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INTRODUCTION
In Nigeria today, most employers of labour insist on computer literacy as one of the
requirements for employment. There are proliferations of microcomputer and WWW
applications in all areas of work. Information technology and communication have
assumed a wider discussion and usage.
Computers are widely used in instruction, teaching and learning in our schools, colleges,
polytechnics and universities. Business centre operation is a much more lucrative venture
today because of the advent of the computer.
There is therefore need for individuals in our society to develop greater awareness in
microcomputing. As a graduate student, you may add value to your university education
and of course, your job by your knowledge of the computer. You will use microcomputer
systems to write, search for information, communicate with your friends and publish your
own web pages if you can afford the necessary hardware and software.
This course will prepare you to achieve your goals and objectives. The course will involve
more practical experiences. However, as a graduate student, you will be involved in
organising seminars in some topics in this course. You will be introduced to the
microcomputer system, main storage devices, input and output devices, connecting
devices to a microcomputer, computer hardware, software and multimedia and their
applications.
You will spend more time on Microsoft Windows basic operations, the Internet and the
World Wide Web (WWW). You will operate the microcomputer to exercise common web
application of word processing and build web pages.

WHAT YOU WILL LEARN IN THE COURSE
The varieties of tasks that microcomputers can perform have profound effects on how
people conduct their lives and work, and pursue education.
In the home, microcomputers can help with balancing the family checkbook, keeping
track of finances and investments, and filing taxes, as well as preserving family
documents for easy access or indexing recipes. Microcomputers are also a recreational
device for playing computer games, watching videos with webcasting, downloading
music, saving photographs, or cataloging records and books. Together with the Internet,
microcomputers are a link to social contacts through electronic mail (e-mail), textmessaging, personal Web pages, blogs, and chat groups. Microcomputers can also allow
quick and convenient access to news and sports information on the World Wide Web, as
well as consumer information. Shopping from home over the Internet with
microcomputers generates billions of dollars in the economy.

WORKING THROUGH THIS COURSE

To go through this course you are required to read the study units, answer the selfassessment exercises and do the assignment in each unit. The self-assignment exercises
are meant to help you to reinforce what you have learnt. It will be very helpful to you to
try and answer the questions first before looking at the answers. At the end of the unit, you
will find an assignment, which will be marked by your tutor. Work diligently on it and
submit your work to your tutor for grading. The tutor-marked assignments will constitute
30% of the total marks of the examination in this course.
You will need to have access to a computer and be familiar with the basic elements of a
computer system. In due course, you will have practical exercises in the library and on the
Internet, and so, you need to have access to these facilities.

COURSE OBJECTIVES
On successful completion of this course, you should be able to:
•
•
•
•
•
•
•

operate a computer using Microsoft Windows
use common Internet tools, browser, email and newsgroups
use word processing software
build web pages
describe basic hardware components, types of software applications and
multimedia concepts
develop the literature on microcomputing and WWW through seminars
conceptualise research topics on microcomputing and www to enhance the quality
of instruction, teaching and learning in our schools.

STUDY UNITS
There are 30 study units which you will work through in this course. There are as follows:
Module 1

Microcomputer Systems

Unit 1
Unit 2
Unit 3

Types of Computers
Components of a Computer System
Computer Memory

Module 2

Basic Operations of Microsoft Windows I

Unit 1

Mouse, Pull-Down Menu, Drag-and-Drag, Keyboard Commands and
Taskbars
Moving and Resizing Windows, Shutting Down, Shortcut Menu, Creating
and Saving in Folder
Looking into My Documents Folder, Moving in and out of Folder
Creating Two Folders in My Documents, Copying and Deleting a Folder,
Copying a File into another Folder

Unit 2
Unit 3
Unit 4

Module 3

Mass Storage Devices

Unit 1
Unit 2

Types of Storage Devices, Basic Operations of Microsoft Windows II
Creating and Moving a Folder and File, Deleting and Restoring Objects,
Locating a File with Windows
Shortcut Path for Windows Explorers, Date/Time Icon in Control Panel,
Changing Background Colour
Changing Display Size and Background Appearance, Exploring Point
Options, Using Desktop Theme in Control Panel

Unit 3
Unit 4

Module 4

Internet and WWW

Unit 1
Homepage
Unit 2
Unit 3

Browsing, Using Links in a Webpage, Setting Browser

Unit 4

Default

Exploring Windows, Adding a Bookmark, and Managing Bookmarks
Searching for Information, Setting Up Mail Account, Creating and Sending
Messages
Creating New Mail Folder and Organising Mail Messages, Newsgroup
Servers, Posting News to Newspapers

Module 5

Input and Output Devices

Unit 1
Unit 2

Types of Input Devices
Types of Output Devices

Module 6

Word Processing

Unit 1

Unit 5

Word Processing: Creating and Saving a Word Document, Opening an
Existing Document, Printing a Word Document
Word Processing: Creating another Document, Text Insertion and Overtype,
Using the Office Assistant
Moving and Copying Text, Moving and Copying Text with ‘Drag-andDrop’, Changing Fonts and Applying Effects
Changing Views in Word 2000, Justifying Text and Using Tabs, Defining
Headers and Footers
Inserting Pictures, Checking Spelling and Grammar, Working with Tables

Module 7

Connecting Services to a PC

Unit 2
Unit 3
Unit 4

Unit 1
Unit 2
Unit 3

Connecting Ports and Connectors
Adding Hyperlinks and E-Mail Link in FrontPage
Using FrontPage to Add Form
Components, Creating and Saving a New Page in
Unit 4
Adding Images and Links in Dreamweaver
Module 8

Computer Hardware, Software and Multimedia

Unit 1
Unit 2
Unit 3
Unit 4

Multimedia Hardware
Multimedia Software
Multimedia Support for Windows
Ergonomics

Dreamweaver

SELF-ASSESSMENT EXERCISES
Self-assessment exercises are embedded in the text of the study units. You should be able
to answer the questions if you study the sections of the units very well.

TUTOR-MARKED ASSIGNMENTS
The tutor-marked assignments are provided in the units. It is absolutely necessary that you
do the assignments and submit your work to your tutor. Make sure that each assignment
reaches your tutor on or before the deadline.

ASSESSMENT
There are two aspects of the assessment of this course. The first aspect is the continuous
assessment through the tutor-marked assignment. The second aspect is the final
examination. The tutor-marked assignments will constitute 30% of the total marks of the
examination in this course. The final examination will come at the end of the course. It
will be a written examination that reflects the exact content of the course. The questions
will not be different from the types you would have already been familiar with in the selfassessment exercises and tutor-marked assignment. The written examination will carry
70% marks.

HOW TO GET THE MOST FROM THIS COURSE
In this programme, you will not be sitting before any lecturer to receive lectures. The
study units will replace the lecturer; you will be reading the study units instead of listening
to a lecturer. You have the flexibility of being able to work through specially designed
course materials at your own pace. You can also choose your time and place of study. The
contents of the units will give you all the information and direction you need.
The units follow the same format. Each unit begins with a table of contents, which tells
you at a glance what is covered in the unit. This is followed by an introduction to the
subject matter of the unit and the relationship of the unit to the previous unit. Then follows
the objectives in which you are told what you should be able to do by the time you
complete the unit. It is advised that you use these objectives to guide your study. After the
objectives, you come to the main body of the study unit. The text of the reading is
presented in a simple direct style to engage your attention and assist your concentration.
You are to go through the unit, section after section. Make sure you fully understand a
section and that you have done the self-assessment exercise there before going to the next
one. The conclusion that follows the main body of the unit gives you an overview of what
you would have achieved in the unit. You should also refer to the objectives of the unit to
assure yourself that they have been met. If you are not satisfied that you have achieved all
that you were expected to achieve, just go through the unit again. The summary of the unit
relates what you have learnt in the unit to the subject matter of the next unit, thus building
a "bridge" between the two units. In this way you can see a logical connection between all
the units.
You will find this course quite interesting and the study units quite readable. The only
problem that you need to worry about is your ability to create a conducive environment
for your study. You have to work out your timetable, time and place of study; and
demonstrate a serious commitment to your study.

SUMMARY
Microcomputers are sometimes called personal computers or micros. Since their
introduction microcomputers have become powerful and extremely versatile tools that
have revolutionised how people work, learn, communicate, and find entertainment. Many

households now have computers, thanks to affordable prices and software that has made
computers easy to use without special computer expertise. Personal computers are also a
crucial component of information technology (IT) and play a key role in modern
economies worldwide.
The usefulness and capabilities of microcomputers can be greatly enhanced by connection
to the Internet and World Wide Web, as well as to smaller networks that link to local
computers or databases. Microcomputers can also be used to access content stored on
compact discs (CDs) or digital versatile discs (DVDs), and to transfer files to personal
media devices and video players.
Powerful PCs designed for professional or technical use are known as work stations. Other
names that reflect different roles for PCs include home computers and small-business
computers. The PC is generally larger and more powerful than handheld computers,
including personal digital assistants (PDAs) and gaming devices.
CIT 659 is neither abstract nor highly theoretical. Both the course aims and objectives
have been set out at the beginning of the guide. They are all realisable and you should not
have any problem achieving them. It is hoped that you will find the course challenging
and interesting.
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MODULE 1

MICROCOMPUTER SYSTEMS

Unit 1
Unit 2
Unit 3

Types of Computers
Components of a Computer System
Computer Memory

UNIT 1

TYPES OF COMPUTERS

CONTENTS
1.0
2.0
3.0
4.0
5.0
6.0
7.0

Introduction
Objectives
Main Content
3.1
Desktop Computer
3.2
Notebook or Laptop Microcomputer
Conclusion
Summary
Tutor-Marked Assignment
Reference/Further Reading

1.0

INTRODUCTION

By now you know that information technology requires the knowledge of computer for it
to function effectively. You need a computer not as a house or office furniture but to
process data/information or even retrieve some data/information.
What kind of computer do you need? This unit will introduce you to the basic
microcomputer that you may want to acquire. Their characteristics will be discussed.
Please read on patiently.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

identify a desktop and a notebook/laptop microcomputer
describe the characteristics of these microcomputers
state the differences between a desktop and a notebook/laptop microcomputers.

3.0

MAIN CONTENT

3.1

Desk Microcomputer

Have you been to any business centre before? Can you recall the type of
microcomputers that you saw there? Most business centres have desktop
microcomputers.
Why do the operators of business centre choose desktop microcomputers? Certainly the
answer is obvious.
A desktop microcomputer is generally cheaper and often more powerful. It can support
all kinds of sophisticated multimedia. These characteristics will depend a lot on the
different specifications it has.
Most desktop microcomputers use CRT monitors although the use of flat panel display is
increasing today. CRT monitors are bulky, heavy, space consuming. They may constitute
potential viewing problems for operators.

3.2

Notebook or Laptop Microcomputer

You have noticed that desktop microcomputers are mostly in use at business centres and
offices. However, for personal usage, the notebook or laptop microcomputer is
peculiarly preferred. Why is this so?
A notebook or laptop PC (personal computer) is portable even though it costs more to
acquire. Generally, it uses a flat panel display. A flat panel monitor is space saving and
relatively light and it generates less heat. The potential viewing problems are never
experienced. A notebook/laptop microcomputer can be carried about in a brief case!
Have you made a choice now on the microcomputer system that you want to acquire?
Please decide quickly since you need a PC for this course. Look at the types of PCs
displayed in Figure 1.

Fig. 1: Different Types of PCs
SELF-ASSESSMENT EXERCISE
1.
2.
3.

Examine a desktop and a laptop microcomputer carefully.
State the physical differences between the desktop and laptop PCs.
Examine some computers adverts and decide which of these you want to acquire.

4.0

CONCLUSION

In this unit, you were introduced to two types of PCs – desktop and notebook/laptop.
You studied their characteristics including the features, functions, applications and
importance. Have you made a choice of which of these to acquire for this course?
Whatever your considerations, you need a PC for this course.

5.0

SUMMARY

This unit has shown that there are two types of PCs. There is the desktop which is very
cheap but bulky in size and weight. It may constitute high viewing problems; however, it
is preferred in most business centres.
The notebook or laptop PC is costly but portable. It has less viewing problems for a
prolonged viewing.

I guess that by now you know that their specifications and potential applications will
affect their choice by individuals.
The next units of this module will describe the different components of the computer
system. Please read on carefully, patiently and effectively.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

State the differences between a laptop/notebook and a desktop PC.
Describe the characteristics of a laptop and a desktop PC.
Examine some adverts on computers. What specifications and applications will
guide you to choose one for use in this course?

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundations in Microcomputing and WWW. ETPU
Publishers.

UNIT 2

COMPONENTS OF A COMPUTER SYSTEM

CONTENTS
1.0
2.0
3.0
4.0
5.0
6.0
7.0

Introduction
Objectives
Main Content
3.1
What is a System?
3.2
Components of a Microcomputer System
Conclusion
Summary
Tutor-Marked Assignment
Reference/Further Reading

1.0

INTRODUCTION

You have selected a PC for yourself and this course. What do you find in a computer
system? Precisely, what is a system?

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

describe the components of a microcomputer system
discuss briefly the functions of these components
identify the basic hardware components of a microcomputer.

3.0

MAIN CONTENT

3.1

Contents of a System

A system consists of interrelated parts that can interact to achieve goals and objectives
by carrying out certain functions and processes. So a system must have input, output,
feedback, functions and goals. How does this apply to a computer system?
3.2

Components of a Microcomputer System

A computer system has four basic components:
1.
2.

Input devices (keyboard and mouse) for which data/information/messages are
typed into the computer.
Central Processing Unit (CPU) for the processing/computing of data and
information within the computer system.

3.
4.

A necessary unit which stores the processed data/results for future use when
retrieved.
Output devices [printer, VDU – Visual Display Unit (monitor)] which can show and
print the results for use.

Fig. 2: A Visual Display Unit (Monitor)
5.

Many components inside the microcomputer system are basically electronic
computers. These are built on a main circuit board (motherboard) inside the PC.
The CPU and the memory are usually attached on the motherboard. The
motherboard has a number of slots where smaller additional circuit boards can be
inserted to add functions to the PC. These are called adapter cards because they
are merely plug-in boards.

6.

There are 3 types of adapter cards:

•
•
•

Sound card (audio card) – sound can be input, processed and delivered.
Display card – will support the display functions (monitor, printer).
Network interface card – computer can be connected to a network i.e. LAN (local
area network).

Central Processing Unit
This is an important component inside the microcomputer. It performs all the data
processing and computation. CPU is a silicon chip which can be square/rectangular
shape and sits on the motherboard. Usually, it has a small cooling fan attached to it
because of the amount of heat it generates at any given operation.
It runs at high speed because of the millions of micro-circuits built inside it.

CPU has 2 major components:
•
•

Arithmetic/logic unit
Control unit.

The arithmetic/logic unit contains the circuitry necessary to perform arithmetic functions
(subtraction, addition, multiplication, division). It performs logical operations e.g.
comparing two numbers. Arithmetic functions and comparison are the basic processing
functions of CPU.
The controlling function of CPU affects the input and output devices.
transferring data to and from the memory.

It helps in

A CPU can retrieve data from the memory, computes/processes it and puts the results
back in the memory. It takes a few seconds for the CPU to process/retrieve data.
SELF-ASSESSMENT EXERCISE
i.
ii.

Examine your computer and the components, identify the different parts.
State their functions.

4.0

CONCLUSION

In this unit, we have been able to describe the components of a microcomputer system.
You have identified the basic hardware components of your computer system. You have
described the functions of the different components.

5.0

SUMMARY

This unit has introduce you to the components of a computer system – input devices
(keyboard, mouse), central processing unit (CPU), output devices (printer, display
monitor) and the memory unit.
You have shown that the input devices enable data/information to be typed into your PC.
The CPU processes the data/information within the computer system. The memory unit
stores the processed data for future use when retrieved. The output devices can show
and print the results for you.
The electronic components inside the PC system are built on a main circuit board called
motherboard. You also studied the adapter cards (plug-in boards) that are slotted into
the motherboard.

You are getting to know more about your PC, the hardware components and their
functions. In the next unit you will study more about the memory system of your PC.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the components of a microcomputer system.
Name the two major components of the CPU.
Discuss the functions of the different components of PC system.
Examine your PC carefully, identify the major hardware components.

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.

UNIT 3

COMPUTER MEMORY

CONTENTS
1.0
2.0
3.0

4.0
5.0
6.0
7.0

Introduction
Objectives
Main Content
3.1
What is a Computer Memory?
3.2
Random Access Memory (RAM)
3.3
Read-Only Memory (ROM)
Conclusion
Summary
Tutor-Marked Assignment
Reference/Further Reading

1.0

INTRODUCTION

In the last unit, we discussed cache memory. You can recollect that a computer system
can process data with a programme e.g. spreadsheet, and produce a result. Such data
must be stored before and after computation.
2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

describe the computer memory
define a byte
describe the function of RAM
describe the function of ROM.

3.0

MAIN CONTENT

3.1

What is a Computer Memory?

A computer memory is a device that stores the data. Computer specialists measure
memory size in bytes. One byte of memory has eight bits which can hold one character.
For example, ‘apple’ requires five bytes to store.

Table 1:
UNIT
Kilobyte
Megabyte
Gigabyte
Terabyte

Memory Unit
ABRREVIATAIONS
KB
MB
GB
TB

EXACT SIZE (bytes)
2 10 /1024
1024 KB
1024 MB
1024 GB

APPROX. SIZE (bytes
1,000
1,000,000
1,000,000,000
1,000,000,000,000

SELF-ASSESSMENT EXERCISE
i.
ii.

Calculate the number of bytes it takes to write microcomputer and WWW.
Storage of information in the computer memory can either be
through:
a.
RAM
Random Access Memory
b.
ROM
Read-only Memory

What do these terms mean in relation to computer memory?

3.2

Random Access Memory (RAM)

When you work on your computer and NEPA takes light you will lose all the information
you had inputted unless you had stored.
The information that is not stored is contained in the MAIN or PRIMARY memory of the
computer system. This is RAM. A typical computer system running windows has 64 MB
to 128 MB or RAM.
The more RAM the system has, the higher the possibility that the CPU can find the
needed data in RAM instead of loading it from the hard disk.
3.3

Read-Only Memory (ROM)

ROM has the characteristics of storing data/messages/information even when NEPA
takes light from your system. It is a memory chip found in the motherboard.
I am sure that you can observe that when you switch on your computer set, a self test
programme shows up before any programme is loaded from the hard disk. This
programme must remain the PC even when NEPA takes light. The programme is stored
in ROM. Such programmes are never changed, they are only read. Hence they have
Read-only memory. ROM is non-volatile i.e. it cannot lose its content. It is used in
sorting small system programmes that boot up the system.
SELF-ASSESSMENT EXERCISE
i.

Calculate the number of bytes it takes to write microcomputer and WWW.

ii.

What do these abbreviations mean as they refer to computer memory?
•
KB
•
MB
•
GB
•
TB

4.0

CONCLUSION

In this unit, we studied computer memory. We described the different memory units.
We also described the functions of RAM and ROM. Our study of the Microsoft system is
progressing gradually.

5.0

SUMMARY

This unit has introduced us to memory units (KB, MB, GB, TB). We learned that the
memory size of a computer is measured in bytes. We were able to describe the structure
and functions of RAM and ROM. The next unit will show much of the basic operations of
Microsoft windows that your PC may have. Please read on carefully and patiently.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.
v.

Define a computer message.
Discuss the structure and function of RAM.
Describe the structure and function of ROM.
Define a byte and state the number of bytes required to store the word
‘microcomputer’.
State one major difference between RAM and ROM.

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.

MODULE 2
Unit 1

BASIC OPERATIONS OF MICROSOFT

WINDOWS I

Mouse, Pull-Down Menu, Drag-and-Drag, Keyboard Commands and
Taskbars
Moving and Resizing Windows, Shutting Down, Shortcut Menu, Creating
and Saving in Folder
Looking into My Documents Folder, Moving in and out of Folder
Creating Two Folders in My Documents, Copying and Deleting a Folder,
Copying a File into another Folder

Unit 2
Unit 3
Unit 4

UNIT 1
USE OF MOUSE, PULL DOWN MENUS, DRAGKEYBOARD COMMANDS AND
TASK BARS

AND-DROP,

CONTENTS
1.0
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3.0
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1.0

INTRODUCTION

How can you operate the Microsoft Windows?
There are a lot of activities involved here. In this unit you will learn to use the mouse.
You will develop skills for operating pull-down menus, drag-and-drop, use of right button
on the mouse, keyboard commands and use of task bars.
Please note the following instructions so that you can perform these activities effectively.
This sign * indicates that you must perform the particular activity. The bold word
indicates the word to use in accomplishing the activity.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•
•
•

use the mouse correctly
operate the pull-down menus
practise the drag-and-drop technique
use the keyboard commands
use the task bar to start a programme and switch between application
develop skills for these activities.

3.0

MAIN CONTENT

3.1

Use of Mouse

You operate a mouse with one hand in order to move a cursor over images or text on a
computer screen. Clicking buttons on the mouse activates, opens, or moves icons or
other graphical objects on the screen when they are displayed under the floating cursor.
To select items or choose commands on the screen, press one of the mouse's buttons,
producing a “mouse click.”

3.2

Pull Down Menu

This is used to make a menu to appear on a computer screen by clicking on its heading.
The computer displays the active area in which the user is working as a window on the
computer screen. The currently active window may overlap with other previously active
windows that remain open on the screen.

3.3

Drag-And-Drop

Can you practise drag and drop?
Follow the instructions below to perform this activity:
•
•
•

Drag point to the Recycle Bin icon.
Click on the left button and hold it down.
Move the mouse.

What do you observe?
The icon will move as the mouse moves.
•

Drop now, release the button.

The icon will stay in its new position on the Desktop.

3.4

Use of Right Button on the Mouse

How do you use the right button on the mouse?
Follow the instructions:
•
•

Point to an icon on the Desktop.
Click the right button.

What do you observe?
The short cut menu of an object is opened by the mouse. Please note that an object
here refers to button, icon or menu.
The short cut menu contains the functions of the object that are used commonly.

3.5

Use of Key Board Commands

How do you use keyboard commands?
Follow the instructions:
•

Press <F 1>

This will open the help and support menu. This will provide explanations for you anytime
you are in difficulty operating your Desktop.
When you want to exit:
•

<ALT> and <F 4> keys at the same time.

3.6

Use of Task Bars

Can you use the task bar to start a programme?
Follow the instructions:
•
•

Click on Start button located at the lower left corner of the screen. You will see
that a menu comes out. The small right arrows indicate the sub-menus.
Move your mouse up the menu to item indicating programmes. The sub-menu
programmes will open.

•
•

Select Accessing by moving the mouse horizontally to the right.
Click Notepad icon.

INSERT some applications found in the programmes menu after clicking on the start
button on the task bar.
How do you use the task bar to switch between applications?
•
•
•

Click on my document. It opens in front of Notepad window.
Click Notepad Task button. Notepad illustrates the active programme
Click both windows at
in the top right hand corner of the window.
X

SELF-ASSESSMENT EXERCISE
i.
ii.
iii.
iv.

Practise how to use the mouse.
Practise how to use pull down menu.
Practise the drag and drop technique.
Practise the use of the task bar to switch between applications.

4.0

CONCLUSION

In this unit, you practised the skills needed for some basic operations of Microsoft
Windows. You used the mouse. You used the pull down menus. You practised the drag
and drop technique. You used the keyboard commands. You used the task bars to start
programmes and switched between applications. This unit is preparing you on
microcomputing.

5.0

SUMMARY

This unit has presented you with activities that will help you develop skills in operating
Microsoft Windows. You used mouse effectively. You used the pull down menus. You
used the drag-and-drop method. You used the keyboard commands. You studied how
to use task bars to start programmes and switch between applications. The next units
will present more activities that will show you how to operate Microsoft Windows.
Indeed, you are learning very fast if you did these activities carefully. You may need to
repeat any of these activities if you are in doubt. Congratulations.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

Describe the steps in using the mouse to operate Microsoft Windows.
Describe the process of using pull-down menus.
Describe the steps needed to use the task bar to start a programme.

iv.
v.

Discuss the use of drag-and-drop method in operating Microsoft Windows.
Describe the difficulties you encountered in the performance of these activities.

7.0
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1.0

INTRODUCTION

Computers have become powerful and extremely versatile tools that have revolutionised
how people work, learn, communicate, and find entertainment. The wide variety of tasks
that computers can perform in conjunction with the computer’s role as a portal to the
Internet and World Wide Web have had profound effects on how people conduct their
lives and work, and pursue education. The learning objectives of this unit are presented
below to enable you perform these activities effectively.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•
•
•

move and resize a window
shut down a computer
use the short cut menu of word pad object
create a word pad file
save this file in a folder
develop skills to perform these activities correctly.

3.0

MAIN CONTENT

3.1

Moving and Resizing a Window

1.

To move a window, do the following:
•
•
•

2.

Move the mouse pointer to the Title bar of the window you want to move
Click Title bar and hold down the left mouse button
Move the mouse to the desired location and then release the mouse
button.

To resize a window, do the following:
•
•
•
•

Move mouse pointer on the side of the window. The mouse cursor will
change to two arrows symbol
Click and hold down the mouse button
Move the mouse horizontally
Release the button.
You can practise this vertically.

3.2

Shutting Down a Computer

You can shut down computer, by doing the following:
•
•

Click the start button
Choose shut down.

Note the shut down windows dialog box
•

Click OK button

Wait until the “It’s now safe to turn off your computer” sign appears.
•

Switch off.

3.3

Using the Short Cut Menu of Word Pad Object

To use the short cut menu, do the following:
•
•

Type some text in the word pad window
Select the text by holding down the left mouse

•
•
•
•
•
•
•
•

Drag the mouse over the text for highlight
Release the mouse
Right click on it to bring up the short cut menu
Select the copy function
Move the cursor to a new position
Right click on it to reveal the short cut menu
Select the paste function
Right click the mouse on the text that you highlighted.

Note that the main task of the pull down menu can be seen.
Note the ellipses (….) after Font and Paragraph. That shows that the menu items will
lead to a dialog box.

3.4

Creating a Word File and Saving it in a Folder

To create a word file and save it in a folder, do the following:
•
•
•
•
•

Open word pad
Type some text
How to file and choose are: The ‘My Document’ folder will appear automatically
Type ‘my first Doc’ in the file name box.
Click save button.

SELF-ASSESSMENT EXERCISE
i.
ii.
iii.

Practise how to move and resize a window.
Practise how to shut down your PC.
Practise how to create word pad file and save it.

4.0

CONCLUSION

In this unit you have been able to move and resize a window. You have shut down your
computer successfully. You have used the short cut menu of word pad object. You have
created a file and saved same in a folder.

5.0

SUMMARY

This unit has shown you how to move and resize a window. You have developed further
skills on how to shut down your PC, create and save a word pad file in a folder. You have
successfully used the short cut menu of word pad object. Your skills in microcomputing
are increasing progressively. Congratulations!

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the process of moving and resizing a window.
Discuss the steps needed to create a word pad file and save it in a folder.
State the steps in shutting down your PC.
Practise any of these activities that you have not been proficient yet. Can you
describe the problems that you encountered?

7.0
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1.0

INTRODUCTION

In this unit you will study how to look into ‘My Documents’ folder. You will also move a
file in and out of a folder. In doing these activities, your skills in basic operation of
Microsoft Windows will increase programming.
2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

develop further skills for operating Microsoft Windows
look into ‘My Documents’ folder
move a file in and out of a folder.

3.0

MAIN CONTENT

3.1

Looking into ‘My Documents’

Follow the instructions below:
•
•

Close word pad
Double-click on the ‘My Documents’ folder

Can you describe what you have observed?
3.2

How do you Move a File in and out of a Folder?

You can move a file in and out of a folder by doing the following:

•
•
•
•
•
•
•
•
•

Use the drag and drop method to move the ‘My First Doc’ file out of the ‘My
Documents’ folder to a space on the Desktop
Drag ‘My First Doc’ back, position it on that ‘My Pictures’ sub-folder
Release the mouse button
Double click the ‘My Pictures’ sub-folder that the ‘My First Doc’ document is now
inside it
Drag ‘My First Doc’ out of the ‘My Pictures’ sub-folder to a space in the Desktop
Release the mouse button
Close the ‘My Pictures’ sub-folder by clicking the cross
Xon the top-right corner
Double click the ‘My Documents’ folder to open it
Use ‘Drag and drop’ method to move the ‘My First Doc’ file from the Desktop back
to ‘My Documents’.

At this point, you should note that you can move folders and files around by doubleclicking and dragging and dropping them into the right place.
SELF-ASSESSMENT EXERCISE
Practise how to move a file in and out of a folder.

4.0

CONCLUSION

In this unit, you have successfully looked into ‘My Documents’ folder. You have moved
files in and out of a folder. Can you remember the steps needed for these activities?
Please practise more.

5.0

SUMMARY

You have developed the necessary skills for further operating Microsoft Windows. You
have looked into ‘My Documents’ folder. You have moved a file in and out of a folder.
That was good if you followed the instructions carefully.
You may wish to repeat any of these activities if you had developed any difficulties and
problems.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

Describe the process of moving in and out of a file into and from a folder.
Discuss the problems/difficulties you experienced in performing these activities.
Practise more on these activities.

7.0
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1.0

INTRODUCTION

You have progressed successfully in operating basic Microsoft Windows so far. In this
unit you will continue to develop further skills in operating Microsoft Windows.
You would create two folders in ‘My Documents’. You will delete a folder. You will copy
a file into another document. Please read and practise carefully.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

create two folders in ‘My Documents’
delete a folder
copy a file into another folder
develop accurate skills for performing these activities.

3.0

MAIN CONTENT

3.1

Creating Two Folders

Please follow the instructions below:
•
•
•

Select New in the file menu
Select Folder in the sub-menu
Choose Folder from the sub-menu produced

•
•

Type your choice name to name the folder
Press <Enter>

3.2

Deleting a Folder

Can you perform this?
If no, then do as follows:
•
•
•
•

Left-click selected folder’s icon
Right-click on the folder
Select Delete
Select Yes.

3.3

Copying a File into another Folder

Do the following:
•
•

Copy the object
Paste it in its destination.

Note that when you copy a file, the original file stays in its folder.
SELF-ASSESSMENT EXERCISE
i.
ii.
iii.

Practise how to create two folders.
Describe the steps needed to delete a folder.
How do you copy a folder into a folder?

4.0

CONCLUSION

In this unit, you have created two folders. You have deleted a folder. You have
developed skills to copy a file into a folder. Well done.

5.0

SUMMARY

This unit has helped you to develop skills for creating two folders. You have succeeded in
deleting a folder. Your skills in copying a file have increased considerably. In the units
ahead you will develop further skills to operate the Microsoft Windows.
Please kindly repeat any of these activities that you may have difficulties and problems
with. You can do all these activities as many times as your schedule will permit.
Congratulations for your patience in studying this unit.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the steps needed to create two folders in ‘My Documents’.
State the steps for deleting a folder.
Discuss how to copy a file into a folder.
Describe the difficulties and problems you encountered when performing these
activities. How can you solve these problems?

7.0
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1.0

INTRODUCTION

Recall that you have learned microcomputer systems in the previous units of this course.
What are these types of microcomputer systems? If you have forgotten, check your
answers with the following:
•
•
•

Computer memory
Input (keyboard, mouse, etc.)
Output (printer, display for using monitor).

Can you add the next one now?
This is the CPU – central processing unit – the master processor!

Please note that there is a difference between the memory devices in a computer system
and the storage devices.
What is the main difference?
If there is any electric power failure and you were working with a computer, if you did
not save your data/information in your hard disk, the computer memory will be lost! On
the other hand, types of storage devices can store your data/information permanently.
We will discuss these storage devices in detail later in this unit. Let us examine what you
will study in this unit in the following specific objectives.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

describe the difference between permanent/secondary
main/primary memories of a computer
describe the types of storage devices
state the speed and capacity of such storage devices.

3.0

MAIN CONTENT

3.1

Different Speeds of Storage Devices

memories

and

What does this mean?
Check your answer with my own. Is there a difference?
Yes, there is. The speed of any storage device will determine how fast the data can be
stored and retrieved respectively.
Capacity determines how the data can be stored only.

3.2

Types of Storage Devices

Compare your answers with mine given below:
•
•
•
•

Floppy disk
Hard disk
Zip disk
CD – ROM

•
•

DVD
Tape

Your computer can readily access your data/information in any location on these devices
except the tape! Why is the tape an exception?
Tapes access data/information in sequence. Let us discuss these devices more than the
mere listing of them:
1.

Floppy disk drives (diskettes)

This is generally described as diskettes. Have you been to any business centre recently?
How does the operator source some of their information/data?
Of course, he/she will use a diskette, an example of floppy disk drive for such storage.
Why does he/she use a diskette? Check your answer with mine below:
A floppy disk drive is very compact and portable. It can be used to transfer the stored
data/information from one computer system to another computer system. The diskette
is very flexible because it is made up of a magnetic crated and protected layered disk.
The diskette is 3.5” and can hold 1.44 megabyte of data. Please note that it is slow when
compared to other storage devices we shall discuss in this unit. When next you visit a
business centre, take a closer look at one of the diskettes.
I guess you should buy some of them because you will be using them to save and transfer
your data/information from one system to the other. It cost very little!
2.

Hard disk

Remember that when you purchased and assembled your computer system, the hard
disk came with it as one of the components. How does it look like? Well it has a rigid
magnetic disk at the spindle. It is fixed and encased in a hard, protective and a
completely sealed metal box. It looks like diskette in size.
What is the major difference between a hard disk and floppy disk/diskette? Can you
guess the answers? Compare your answers with mine below?
Hard disk is described in terms of access time and capacity. What is an access time? This
is the average time it takes the hard disk to access the data. It is measured in
milliseconds. What is a million? Then this is really fast and large.
However, note that the smaller the access time, the faster the hard disk.

3.

Zip drives

What about this? Can you recall the speed and capacity of floppy disks? Generally,
floppy disks are slow with 1.4 MB capacity. If you have to transfer a 50 MB file, how long
does it take and how many of such floppy diskettes will you need?
You will require 36 diskettes taking so many hours! If you had operated a business
centre, I am not sure that you will be breaking even! So what do you do?
You will need the Zip drive with a large storage capacity. How much? It can hold up to
250 MB of data with a faster access time closer to the hard disk. Can you recall the
features of the hard disk? It rotates in milliseconds! Are there other features that a Zip
disk has which a floppy disk does not have?
Yes, the magnetic coating in Zip disk is of a higher quality than floppy disk. This major
characteristic allows the Zip disk to have a higher storage capacity than floppy disk. The
cost of a Zip disk drive and hard disk is much higher than a floppy disk drive and diskette.
You can transfer a larger amount of data. Can you now make a choice to acquire any of
these disks/drives? Containing the amount of work/files that you want to transfer will
determine such a choice.
4.

Tape drives

Tapes were used in the early days of computer technology/industry as storage medium.
It is stable and mature. It is very cheap. The storage capacity and access time for data
constitute a major setback for their use.
Remember that the tapes can store/retrieve data only in sequence. Do you use small
cassette records for musical entertainment? You need to either forward or back down
your favourite musical piece to enjoy it. Therefore, it takes a much longer time to store
and retrieve the data for use. So what do you want to use the tapes for?
Tapes are good for backing up or archiving data/information. Tapes can have a storage
capacity of 100 GB, especially with digital tape drives.
5.

CD – ROMs

What is CD – ROM? Can you remember this when we discuss computer memory in unit 3
of module 1?

CD – ROM you will recall means Compact Disk Read Only Memory. It is like your
favourite music CD used in a CD player. It has pre-recorded data with a storage capacity
of 600 MB. You can only read the data but you cannot save data on it. A CD – ROM drive
will only read and transfer the data from the CD – ROM to the computer.
Can you remember the difference between ROM and RAM now? Please cross check your
answer with the information from unit 3 of this course.
The access time of a CD – ROM is measured in multiples of ‘X’. A/X CD – ROM can
transfer data at 150 KB/second. With increase in technology, CD – ROMs have an access
time of 32X. This is a fast speed. Therefore, the higher the X, the faster the CD – ROM
can transfer data to your computer.
Data is stored in the form of small bumps on the disk’s surface. A laser is used to reflect
light off the coding of these bumps and a light sender is used to translate this
information into electrical signals. Laser beams have very short wavelength and can be
focused very precisely. CD – ROM is generally described an optical disk. It uses a plastic
disk with a thin film coating on the surface.
What is another example of the optical disk? Remember DVD can hold data up to 4.76
GB. Do you still remember the memory unit of your diskette? Yes, cross check your
answer. It is only 1.4 MB on a 3.5” floppy diskette.
What are the other variants of CD – ROMs? Remember, CD – ROMs can only read
stored/retrieved data!
•
•

CD – R meaning Compact Disk Recordable; i.e. you can write data to it once only.
CD – RW meaning CD Read Write. That is it can read and write data multiple
times. It has slow writing process. It can be used for storing large amounts of
data as used in multimedia production works.

6.

DVDS

What is a DVD?
It means Digital Versatile Disk. It is a second generation CD – ROM. DVD drives and disks
resemble their CD – ROM counterparts but they have a higher capacity range from 5 GB
– 17 GB. They have faster access time. For example, a 1 x DVD drive can transfer data at
1250 KB/second.
What can DVD store? Because of its versatile nature it can store videos and music and
computer data. There are other variants of DVDs: what are these?
•
•
•
•

DVD Video – for encoding and playing movies on DVD movies players. It uses
MPEG – 2 compression scheme.
DVD – RAM – counterparts of CD – R/RW drives; i.e. rewritable media. It can use
single 4.7 GB sided or double – sided 9.4GB erasable discs.
DVD – R/RW – uses write-once and rewritable discs.
DVD – Audio – can deliver multi-channel sound outside stereo. You access artist
names, titles, lyrics, live notes, etc.

I want you to do another seminar on these disks/drives. Can you read more and write a
term paper of about 5 – 10 pages of A4 presentation on CD – ROMs and DVDs.

Fig. 1: Types of Storage Devices
SELF-ASSESSMENT EXERCISE
Write the seminar paper on types of storage devices. Do not exceed 10 pages
double spaced paper.

of

A4

3.3

Drag-and-Drop

Can you practise drag and drop?
Follow the instructions below to perform this activity:
•
•
•

Drag point to the Recycle Bin icon
Click on the left button and hold it down
Move the mouse.

What do you observe?
The icon will move as the mouse moves.
•

Drop now release the button.

The icon will stay in its new position on the Desktop.

3.4

Use of Right Button on the Mouse

How do you use the right button on the mouse?
Follow the instructions:
•
•

Point to an icon on the Desktop
Click the right button.

What do you observe?
The short cut menu of an object is opened by the mouse. Please note that an object
here refers to button, icon or menu.
The short cut menu contains the functions of the object that are used commonly.

3.5

Use of Key Board Commands

How do you use keyboard commands?
Follow the instructions:
•

Press <F 1>

This will open the help and support menu. This will provide explanations for you anytime
you are in difficulty operating your Desktop.
When you want to exit:
•

<ALT> and <F 4> keys at the same time.

3.6

Use of Task Bar

Can you use the task bar to start a programme?
Follow the instructions:
•
•
•
•

Click on Start button located at the lower left corner of the screen. You will see
that a menu comes out. The small right arrows indicate the sub-menus.
Move your mouse up the menu to item indicating programmes. The sub-menu
programmes will open.
Select Accessing by moving the mouse horizontally to the right.
Click Notepad icon.

INSERT some applications found in the programmes menu after clicking on the start
button on the task bar.
How do you use the task bar to switch between applications?
•
•
•

Click on my document. It opens in front of Notepad window.
Click Notepad Task button. Notepad illustrates the active programme.
Click both windows at
in the top right hand corner of the window.
X

SELF-ASSESSMENT EXERCISE
i.
ii.
iii.
iv.

Practise how to use the mouse.
Practise how to use pull down menu.
Practise the drag and drop technique.
Practise the use of the task bar to switch between applications.

4.0

CONCLUSION

In this unit, you have studied different types of storage devices. You have described their
characteristics. You have discussed their access time and capacities. This is a very
important unit that you should be reading regularly for you to do your works effectively
and efficiently.

5.0

SUMMARY

In this unit, storage devices include floppy disk, hard disk, zip disk, CD – ROM, DVD and
tapes. You have studied their capacity and access time that is measured in bytes and
milliseconds and X respectively.
For example: a floppy disk has 1.4 MB on 3.5” dimension while DVD may have 10 GB. A
CD – ROM has an access time and capacity of 150 KB/second at least with about 32 X.
You also studied the variants of CD – ROMs and DVDs. If you have examined these
storage devices, then you should be able to differentiate one CD – ROMs from DVDs and
floppy disks from hard disks. Congratulations!

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

Describe the types of storage devices for data for a computer system.
State the differences between CD – ROMs and DVDs.
List the variants of CD – ROM and DVD.

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.

UNIT 2

CREATING AND MOVING A FOLDER AND FILE,
RESTORING OBJECTS,
LOCATING A FILE WITH WINDOWS

DELETING AND

CONTENTS
1.0
2.0
3.0

4.0
5.0
6.0
7.0

Introduction
Objectives
Main Content
3.1
Creating a New Folder
3.2
Moving a File into the Folder
3.3
Deleting and Restoring an Object
Conclusion
Summary
Tutor-Marked Assignment
Reference/Further Reading

1.0

INTRODUCTION

The use of your microcomputer will not be complete unless you have developed skills in
performing certain tasks. In this unit, you will further create and move files and folders.
You will delete and restore objects. You will locate a file using window search.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

develop skills in performing some basic operations of the Microsoft Windows
create files and folders
delete and restore objects
locate a file using windows search.

3.0

MAIN CONTENT

3.1

Creating a New Folder

•
•
•

Select the ‘My Documents’ folder in the left pane of Windows Explorer.
Select New in the File menu.
Select Folder in the sub-menu. Note that another sub-menu comes out. A
highlighted new folder with a default name ‘New Folder’ appears in the pane.
Type welcome to National Open University of Nigeria in the box under the folder.
Press <Enter> to end.

•
•

3.2

Moving a File into the Folder

•

Use the ‘drag-and-drop’ method to move the ‘My First Doc’ file out of the ‘My
Documents’ folder to a space on the Desktop.
Drag ‘My First Doc’ back.
Position it over the ‘My Pictures’ sub-folder.
Release the mouse button.
Double click the ‘My Pictures’ sub-folder so that the ‘My First Doc’ document is
now inside it.
Drag ‘My First Doc’ out of the ‘My Pictures’ sub-folder to a space in the Desktop.
Release the mouse button.
Close the ‘My Pictures’ sub-folder by clicking the cross X
on the top-right
corner.

•
•
•
•
•
•
•

You can now practise this activity with what you had typed into your computer when you
created the folder ‘Welcome to National Open University of Nigeria’.
You will need to do this several times. You can think of creating other folders and
moving the files into them accordingly.

3.3

Deleting and Restoring an Object

To delete a folder, ‘Welcome to the National Open University of Nigeria’ you will need to
carry out the following operations:
•
•
•
•
•

Left-click the folder’s icon to select folder
Right-click on the folder. Note that a short cut menu appears.
Select Delete
Note that a dialog box (Delete) appears on the box
Click Yes.

Practise deleting ‘Welcome to the National Open University of Nigeria’. You can type
other documents and practise to delete. Follow the following steps to restore an object:
•
•

Copy the object
Paste it in its destination location.

Practise this several times to be sure you are doing well.
SELF-ASSESSMENT EXERCISE
i.
ii.
iii.

Create a folder ‘Microcomputing and WWW’.
What are the steps to follow?
Delete a file from the folder ‘Microcomputing & WWW’.

iv.

What are the steps to follow?

4.0

CONCLUSION

You have practised the necessary skills to create a folder, move a file into a folder, delete
and restore objects and located a file. You will need to do these activities several times
with your PC to prepare grounds for other activities.

5.0

SUMMARY

In this unit, you studied by practising the necessary steps to create, move, delete, restore
and create files from folders. It was a good exercise. You will need all of these later in
subsequent units.

6.0

TUTOR-MARKED ASSIGNMENT

i.
(a)
Discuss the steps you will take in creating a folder and
a file into it.
(b)
Practise these activities with over 10 cases.
ii.
(a)
How do you delete and restore an object?
(b)
Describe the stages/steps to follow.
iii.
What will you do in locating a file from the same window?

7.0
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1.0

INTRODUCTION

In this unit, you will express and practise the shifts for making a short cut path for
windows explorer. You will use date/time icons in the control panel and change
background colour of your screen. Like we discussed previously, your use of
microcomputer will depend on your mastery of these shifts in performing these
activities.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

make a short cut path for windows explorer
use the date/time icons in the control panel
change the background colour in your monitor.

3.0

MAIN CONTENT

3.1

Making a Short Cut Path for Windows Explorer

•
•
•
•
•
•
•

Check on Start button presented at the lower corner of the screen
Move your mouse up the menu until you read the item programmes
Select Accessories from the programme sub-menu
Click the Notepad icon
Launch the application – Windows Explorer
Right click on windows explorer to bring up Create Short cut
Select Create Short cut

Note that a short cut ion will appear.
•
•

Drag the icon on the Desktop
Double-click the icon to launch windows explorer.

Alternatively, right-click on the windows explorer icon, short cut menu will appear.
•

Choose Rename to rename it as windows explorer.

Practise this all over to make a number of short cuts. Usually, they take very little hard
disk. If you delete a short cut, the original file will not be deleted.

3.2

Using the Date/Time Icon in the Control Panel

•
•

Double-click the Date/Time icon inside the control panel
Check the date/time on your computer.

You can set your time and date accordingly.
•
•

Close this icon
Double click the time to get more information about time and date settings.
Repeat this until you are perfect.

3.3

Changing the Background Colour

Do you want to change the background colour on your Desktop? What colour is it?
Please perform the following operations and you can have your desired background
colour:
•
•
•
•

Double click the Display icon inside the control panel
Select Appearance tab
Change the background colour of your desktop by choosing a different colour
from the pull-down menu
Close the Display Properties windows when you have chosen the desired colour.

Your background colour should be different! What about this? Can you repeat these
steps? Where do you have problems? Please read the instructions again and repeat the
operations:

SELF-ASSESSMENT EXERCISE
i.
ii.
iii.

Practise each of these operations discussed in this unit.
Note the problems encountered.
Read through the unit and observe your desktop screen always/after each activity.

4.0

CONCLUSION

In this unit, you made short cut path to windows explorer. You used the Date/Time icon
to set your date/time as you wanted. You have changed the background colour of your
desktop screen several times to your desired colour, taste, and mode. Practise more.

5.0

SUMMARY

This unit has introduced you to the steps and problems of making a short cut path to
windows explorer, setting time/date by using the Date/Time icons and changing the
background colours of your desktop screen. Can you list these steps and problems?
Please practise more.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.

Discuss the steps and problems of setting the Date/Time in your microcomputer
and changing the background colour of your desktop’s screen.
Practise these operations several times to master these shifts.

7.0
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1.0

INTRODUCTION

So far, you have been practising different shifts in the operation of Microsoft Windows.
This unit will lead you to change display size and background appearance of your desktop
screen. Please concentrate well on these skills.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•
•
•

describe shifts in operating basic operations of Microsoft Windows
change display size of your desktop screen.
change the background appearance of your desktop screen
describe the steps in performing these shifts and operations
use Desktop there in the Control Panel
explore the print options of your printer.

3.0

MAIN CONTENT

3.1

Changing Display Size and Appearance

Can you read the windows and print on your Desktop easily? Can you make them bigger
or smaller?
Follow the steps below to reveal the skills necessary for such operations:

•
•

Double click the Display icon inside the Control Panel
Select the settings tab.

Can you see anything on your Desktop screen? Compare with your answer. There is a
picture on the screen monitor. What is the function of the screen monitor? You can
recall these from unit 2 of module 1 (components of the computer system). It is a visual
display component for your data/information.
You can also see a sliding control known as ‘Screen area’ under the picture.
•
•
•

Put your cursor on this control.
Drag the sliding control. What do you observe? A new display size can be seen.
Drag to the left. How does the windows and print look like? Compare your
answers with mine.

A larger window and print on your Desktop screen monitor.
•
•
•

Drag to the right. Compare the size of the window and print on the Desktop
screen monitor now with the first one. They became smaller. Are you sure!
Click apply. What do you see? A Display Properties Dialog box appears to inform
you what the windows can do. Read the instructions carefully.
Click OK.

What can you see after some minutes? Compare your answers with mine.
•
•

Windows will come up with a display setting.
A dialog box will appear asking you to accept or reject such a display setting.

Were these your own answers? If your answers are no, you may want to repeat this
activity until you are satisfied.
Please note that if you had clicked the NO option, windows will revert back to the old
setting.
Practise this activity again selecting different display sizes until you are satisfied.

3.2

Changing the Background Appearance of Your Desktop Screen Monitor

Have you seen the screen monitor of your friend when there are no data on them?
They may have nice and interesting pictures/designs on their Desktop. You can design
your own background appearance. Follow these steps and skills carefully for this activity.
•

Double-click the Display icon inside the Control Panel

•

Select the Background tab.

What can you see? Compare your answers with mine. The current background picture
as a well proper is ф (NONE).
•
•

Use the right scroll bar to scroll downward
Select a new choice. What can you see? Cross check this with your observation
please.

The effect of your choice will appear on the centre display screen.
•
•
•

Practise with other options
Pick a background of your choice
Click Apply.

Note that you can revert back to the original background by selecting ф (None).
It looks very easy. Practise more.
3.3

Using the Desktop Theme

Can you use your Desktop Theme in the Control Panel? It is very easy to accomplish
because Microsoft can provide a Desktop Theme tool in the Control Panel. Now follow
the following instructions:
•
•
•
•
•

•

Bring up the Control Panel
Select View all Control Panel Options if you cannot see the Desktop Theme icon
Double click the Desktop Theme icon inside the Control Panel
Click to *activate to activate the Theme: menu in the Desktop Theme window.
Select Inside your Computer (high colour). Your computer will process your
selection for a moment. A brand new display in the Desktop Theme on the
window will appear. You can select another one by following the above steps and
instructions.
Click Apply.

What do you see? A transformation in the screen monitor of your Desktop.
As usual, please practise this activity further until you are satisfied.
3.4

Exploring the Print Options

Can you explore the print options of your computer?

Please go to the Help menu and you will have all the instructions to follow.
By now you should become more efficient in the operations of Microsoft Windows. You
will need to carry out these exercises to test your proficiency.
SELF-ASSESSMENT EXERCISE
i.
ii.

How do you change the background appearance of your Desktop screen monitor?
How do you change the display size?

4.0

CONCLUSION

In this unit, you have changed display size, background appearance of your Desktop
screen monitor. You have followed the steps and skills of the operations. You have
received feedback from me and your microcomputer. You can use Desktop Theme in the
Control Panel. All these activities are arrived at giving you step-by-step instructions for
practising the different skills and applications in the operations of Microsoft Windows. If
you have followed them carefully then you should becoming an expert in operating
Microsoft Windows.

5.0

SUMMARY

This unit has further increased your knowledge in the operations of Microsoft Windows.
You could change display size, background appearance and use Desktop Theme in the
Control Panel. These activities will enable you study subsequent operations in the
Internet web pages and your practising of the word processing exercises and activities.
Congratulations!

6.0

TUTOR-MARKED ASSIGNMENT

i.

Discuss the steps you will follow to:
a)
b)

Change your display size
Change background appearance of your Desktop screen monitor.

ii.
iii.

How will you use the Desktop Theme in the Control Panel?
Practise these activities until you are satisfied. You may need to read through this
unit again. Do not forget your microcomputer will form a big comparison to
achieve/complete these activities.

7.0
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1.0

INTRODUCTION

In this unit, you will browse the NOUN homepage, use links in a webpage and set a
browser default homepage. This unit involves your development of practical skills in
operating the Internet and WWW.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

browse the NOUN homepage
use links in a webpage
set a browser default homepage.

3.0

MAIN CONTENT

3.1

Browsing NOUN Homepage

Follow the steps below to reveal skills that are needed for these operations:
•

Start Internet Explorer within your computer. Note that the National Open
University of Nigeria homepage will be displayed on your screen. Take note of
text box in the centre of the toolbar.

http://www.noun.edu.ng/
This is the website address of the National Open University of Nigeria. You may notice
that your screen may indicate a different homepage. Please delete the text in the
location box on your screen.
•

Type in:
http://www.noun.edu.ng

•

Press <Enter>

As you pressed <Enter> note that the icon in top right hand corner of the Internet
Explorer has transferred the information to your PC. A new webpage is shown when the
transfer is completed.
3.2

Using Links in a Webpage

Follow the steps indicated below to demonstrate the skills for this operation.
•

Move your mouse cursor over the webpage. What do you observe? Notice that
sometimes it changes to form an (arrow) ⇑ to a (finger).

Can you suggest what this means? Cross check your answer with mine that is given
below:
The finger indicates a link to another webpage.
•

Click on the link.

What do you observe?
You can see that you can move easily to the other page.

•

Click on

What do you observe?
•

A new page on NOUN programmes and course information will show. You can
select any of these for study.

3.3

Setting a Browser Default Homepage

Please follow the steps indicated below to avail yourself the skills you will need to
operate.
•
•

Click on the Edit menu
Select Preference ….

What do you observe?
Note that a dialog box appears.
•
•
•

Select the homepage radio button and in the Location : bar.
Type in: www.noun.ng
Click on [ ⇑ OK ] to finish the setting.

Remember that when you next start on Internet Explorer, or when you click on the [⇑
Home] button at the top, Internet Explorer will automatically go to the homepage of
National Open University of Nigeria (NOUN).
SELF-ASSESSMENT EXERCISE
i.
ii.
iii.

Practise these skills on: browsing the NOUN homepage, using links in a webpage
and setting a browser default homepage.
What are the problems you have encountered?
Repeat the steps several times.

4.0

CONCLUSION

In this unit, you have browsed the NOUN homepage; used links in a webpage, and set a
browser default homepage. These activities are designed to provide you a step-by-step
instruction for practising the skills in operating the Internet and WWW.

5.0

SUMMARY

From your study of this unit, you have increased the practised skills in operating the
Internet and WWW. You were able to browse the university’s homepage, use links in a
webpage and set a browser default homepage. These activities will enhance the
studying the other activities subsequent units of this module.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.

Discuss the problems you encountered in practising to browse your university’s
homepage and using links in a webpage.
Practise how to set a browser default homepage.

7.0
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1.0

INTRODUCTION

In the previous unit you practised how to set a default homepage. You browsed another
homepage on your computer outside the university’s homepage. You remember that I
asked you to type:
http://www.noun.edu.ng
In this unit, you will explore windows in the web and you will explain the abbreviations.
You will also add a bookmark in the bookmark and manage the browser to your
advantage.
This unit will help you to develop additional skills by carrying out activities presented
below. Please read on.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

explore windows Me on the web
add a bookmark in the browser
manage bookmarks.

3.0

MAIN CONTENT

3.1

Exploring Windows Me on the Web?

Please perform the following activities with your computer:
•
•

With the browser on, type: www.microsoft.com in the location bar
Press <Enter>

What do you observe? Of course you will notice that you are at Microsoft homepage.
Remember that Microsoft can provide products which help you find specific information.
What are these? Can you cross check your answers with mine?
Home
Search

Events

Search Box

Training

Provided in the top left of the page.
•
•

Go

Type Windows Me inside the box
Press Go.

What is Me? The word ‘Me’ stands for Millennium Edition; i.e. the software that
Microsoft is using currently.
What can you observe?
Note that a set of underlined Web links can be displayed on your screen. Your best bets
for Microsoft Windows Me:
•
•
•

Homepage for Microsoft Windows Me
Support Highlights for Windows Me
Books for Microsoft Me

•
•
•

Click on one of the links that you want
Use the ⇐ (Back) and ⇒ (Forward) button to switch between pages.
Use the button
Home to go back to your default homepage.

3.2

Adding a Bookmark in the Browser

Just follow the instructions to be able to perform these activities:
•
•

Type: http://www.info.gov.ng/ngo/ in the location box
Press <Enter>

What can you observe?
This will bring up the homepage for Nigerian Observatory.

•
Click on the Bookmark’s button on the top menu
•
Selection Add current page.
Bookmarks
Tasks
Add
Current Page
Manage
Bookmarks……
Click
•

Help
Ctrl + D
Ctrl + B

Home button to go to your default homepage
Click on the bookmark’s button again.

What have you observed? Of course, a new entry will appear. What is this new entry?
You should provide the answer now. Look at the bottom of the bookmark’s menu. What
do you see?
•

Click on this new entry and you will be taken straight to the Nigerian Observatory
homepage again.

Please note that the address of the page has been stored in the bookmark. How do you
like this activity? You will need to provide more to acquire the necessary skills.

3.3

Managing Bookmarks

You might have noticed that you have bookmarked many sites on the Web. Can you
organise and manage these sites? Why do you need to organise and manage sites?
Please follow the following instructions to enable you provide answers to the above
questions in this section:
•
•
•
•
•
•
•
•
•
•

Click on the Bookmark’s button
Chose Manage Bookmarks ……..
Click on File menu
Choose New Folder to create a bookmark folder
Type weather in the name box. What can you observe so far? You should notice
that the bookmark window will show a new folder called ‘Weather’.
Click OK
Highlight it by clicking on the bookmark. At the point in time, what other
operations can you use? Of course, cut-and-paste.
Click the Edit menu
Choose cut.
Click on the ‘Weather’ folder to highlight it

•
•
•
•
•
•

Click the Edit menu again
Choose paste. Why are you carrying out these activities? Of course, you want to
put bookmark into the folder. So bookmark is now in the ‘weather’ folder.
Click File menu from the bookmark windows
Choose Close to enable you close the bookmark.
Click on Bookmark in the pull-down menu. What can you observe? Certainly the
‘weather’ folder appears.
Move your mouse on it. What have you observed? The Nigerian Observatory will
appear

SELF-ASSESSMENT EXERCISE
i.
ii.

What did you notice about these activities in this unit?
How do you organise and manage bookmark?

4.0

CONCLUSION

In this unit, you have been able to explore Windows Me on the web. You have added a
bookmark in the browser. You have organised and managed bookmarks. This unit was
designed to help you understand further operations in the Internet and WWW. I am sure
that you have followed the activities carefully.

5.0

SUMMARY

You were able to explore Windows Me, add a bookmark in a browser and web. You are
certainly moving forward. You will need to practise these skills more than what you have
done now.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the steps involved in exploring Windows Me.
Describe how you can add a bookmark to a Web page.
Discuss the problems that you encountered in doing all these activities?
Practise more of these activities at your own spare time and speed. But consider
the cost!

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.

UNIT 3
SEARCHING FOR INFORMATION, SETTING
UP
ACCOUNT, CREATING AND
SENDING MESSAGES

MAIL

CONTENTS
1.0
2.0
3.0

4.0
5.0
6.0
7.0

Introduction
Objectives
Main Content
3.1
Searching for Information on the WWW
3.2
Setting Up a Net Scope Mail Account
3.3
Creating and Sending a Message in Net Scope Mail
Conclusion
Summary
Tutor-Marked Assignment
Reference/Further Reading

1.0

INTRODUCTION

You have browsed your homepage, explored windows so far. In this unit, you will be
exposed to the development of more operational skills in the Internet and WWW. You
will study how to search for information on the WWW. You will set up a Net Scope Mail
Account in a Net Scope 6. You will create and send a message in Net Scope mail. Please
read with caution.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

search for information on the www
set up a Net Scope mail account in a Net Scope 6
create a message in Net Scope mail
send a message in Net Scope mail.

3.0

MAIN CONTENT

3.1

Searching for Information on the WWW

By now you are aware of the fact that the Web has windows of sites. You can find
information about all kinds of topics, organisations, products and services on the WWW.
What will you do if you want to access the website of a supermarket chair to buy your
foodstuffs and other products? Do you know the Webs page address of your favourite
supermarket? In order to answer these questions, you will need to do the following:

•

Type in the name of the supermarket chain in Net Scope location bar.
*

Π Park n Shop
•

Search

Press

What have you observed?
Note that the list of related links is returned. For example:
Search Results for ‘park n shop’
Reviewed websites
Websites reviewed and categorical by a team of
o

Park n Shop

On line shopping facility
http://www.parknshop.com/
found in : Regional > Africa > Nigeria > Business and Economy > Shopping > Supermarkets
•
•
•

Click on the Website line for Park n Shop to go to the website.
Explore the Park n Shop site by clicking on some of its links. Consider another
shop that you would like to visit for some ‘cyber shopping’.
Type the name of the shop or chain in the Net Scope location box.

•

Press

Search

Explore the list of related links that Net Scope gives you.
Practise this activity again.
3.2

Setting Up a Net Scope Mail Account

Remember that in your course, Introduction to the Internet, you had communicated
through the e-mail. This unit will be very useful to you in further communicating through
e-mail.
Note also that Net Scope 6 comes with an e-mail function called Net Scope Mail. Can you
send and receive e-mails?

Please provide identity for your e-mail account. Provide the name of your domain server
or ‘post office’.
Please follow the instructions below in order to start a Net Scope e-mail account:
•

Choose Mail from the Net Scope 6 Tasks menu

Why do you do this activity? This will enable you to bring up Net Scope mail.
•
•
•
•
•
•
•

Click Edit menu in the Net Scope window.
Select Mail/News Account settings. What can you observe? An account setting
window appears.
Click on New Account button. A new Account Set up window will appear.
Select the account type.
Click Next. What can you observe? An Account Wizard Identity window will
appear.
Enter your name and e-mail address.
Click Next. Can you observe anything on your screen that is different from the
previous exposures? Certainly, but this time you will have:

An Account Wizard: Server Information Window.
•
•
•
•
•
•
•
•

Select the server Type: POP Mail Server.
Enter the name of your incoming mail server. Note that an Account Wizard: User
Name window will appear.
Enter the user name given to you by your e-mail provider.
Click Next. Notice that an Account Name window will appear.
Enter the name by which you would like to refer to this account.
Click Next. What do you observe? A new window will appear.
Click the Back button to make any corrections.
Click finish to save your settings. Can you see that you have created an e-mail
account in your Net Scope window? You are ready to send and create messages
in Net Scope Mail. You will be introduced to these activities and the steps you
should follow in the next section of this unit.

3.3

Creating and Sending a Message in Net Scope Mail

The next set of activities will provide all the necessary instructions for you to accomplish
them
•
•

Select Mail Folders from your e-mail folder
Click the New Message button in the mail toolbar from your e-mail folder. What
do you observe? Note that the Net Scope composition window will appear. You
are ready to compose your message.

Are you ready? Now try the following:
•
•
•
•
•
•

•
•
•
•
•

In the ‘To’: field, type the e-mail address of any of your friends. What can you
observe? The field will specify the e-mail address that you want to send the
message to.
Press Enter. Note that another ‘To’: field appears.
Type your lecturer’s/friend’s e-mail address also.
Press Enter. Note that another ‘To’: field appears.
Click on the To button down arrow.
Choose Cc: What is the meaning of Cc:? It refers to carbon copy. If you want to
send anyone a copy of your message, it is always advisable to type his/her e-mail
address here. When you do this you would receive a copy of the e-mail messages
in your Inbox.
Type in your own e-mail address.
Type ‘Hello’ in the ‘Subject:’ field; i.e. the subject of your message. Note that it
becomes advantageous when you need to identify a particular message from a
large number of displayed messages in the mail window.
In the text box type your message.
Send

Click the
button to send the message. What can you observe? If you
have sent the message according to the instructions stated above you can see that
the new mail has been delivered.
Click the ‘sent’ folder. Note that your messages will be listed in the ‘sent’ folder.

SELF-ASSESSMENT EXERCISE
i.
ii.

Practise creating and sending messages from the steps above.
What are the problems you have noticed?

4.0

CONCLUSION

In this unit, you followed instructions to search for information on the WWW. You set up
on Net Scope mail account in Net Scope 6. You created and sent a message in Net Scope
mail. Did you find these activities easy to perform? You will need to practise more on
these.

5.0

SUMMARY

You have developed the skills for searching information on the WWW. You have set up a
mail account using the Net Scope 6. You have created and sent messages to your
friends. These are all the activities you will be doing almost on a daily basis. You will
need to practise these skills more than what you have done.
Remember that the more the practise the greater your efficiency in creating and sending
e-mail messages.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.
v.

Describe the steps in searching for information on WWW.
State the steps in setting up an e-mail account.
Create and send an e-mail to your friends.
What are the problems that you observed when carrying out these activities?
How can you improve on the development of these skills?
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1.0

INTRODUCTION

In this unit, you will practise the skills needed for you to create a new mail folder. You
will organise the mail messages. You will set up a newsgroup server. You will post news
to newsgroup. These skills will facilitate your understanding of communicating through
e-mail efficiently.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

create a new mail folder
organise the mail messages
set up a newsgroup server
post news to newsgroup.

3.0

MAIN CONTENT

3.1

Creating a New Mail Folder to Organise Mail Messages

By now you have received more and more e-mails from your friends, students, lecturers
and family members. In order for you to handle all these messages you will need to
organise them into categories/folders.
How do you go about organising your e-mail into folders? Please read through the
instructions presented below so as to develop the necessary skills for them. In this way,
you can store and organise your messages in a systematic manner.

Please follow these instructions:
•
•
•
•
•
•
•
•
•

Click on the File menu
Chose New, then Folder
Type ‘office’ as a new folder name
Click OK button to accept current settings in the Create as sub-folder of – selection
menu
Select a message from the message list window to be put into the new folder
Highlight the message
Click on File What can you observe? Note that the list of folders available will
be shown.
Choose Office. What can you observe? The highlighted message will disappear
from the message list window.
Click on office in the mail folders pane. How is your window now? Notice that the
message will reappear in the message list window of the ‘office’ folder. This
shows that the message has been successfully moved to the office folder.

It seems easy to organise your message into a folder! Please practise this skill again by
giving it a new name and follow the steps illustrated above.
Can you do this activity successfully? You can now proceed to another activity.

3.2

Setting up a Newsgroup Server

How do you handle this activity?
You will need to develop the skills for this activity. Please follow the instructions
carefully.
In Net Scope Mail of your computer:
•
•
•
•
•
•
•
•
•
•

Click on File in the menu
Choose New
Choose Account
Select Newsgroup account in the New Account setting dialog box.
Click Next
Type your name and the e-mail address in the identity dialog box for which you
will post the message to the newsgroup.
Click Next
Enter: news.students.noug.edu.ng in the server Information dialog box.
Click Next
In the Account Name dialog box that popped up, type in the name you want to
use for your account. What can you observe? Note that your news server name
will appear in the name field as default.

•
•
•
•
•
•
•
•

•

3.3

Click Next. What is on your window now? Of course a Congratulations dialog box
will pop up.
Click in Back button to make any corrections.
Click Finish to save the settings.
Return to Net Scope Mail. Note that in the mail account, you will find
‘news.student.noun.edu.ng’ appears in the Mail Folders.
Select the newsgroup within the newsgroup server that you intend to
communicate with.
Highlight ‘news.student.noun.edu.ng’ account.
Click File.
Choose subscribe ….. What can you observe? Note that a subscribe dialog box
will pop up. The newsgroup available in the news.student.noun.edu.ng server will
be listed in the central pane. When you return to Net Scope Mail window, all the
messages that have been posted will appear in the message list window.
Select the message you want to read in the message list. Note that the
corresponding message will be displayed in the message dialog box

Posting News to a Newsgroup

In the last activity you were able to post your message to other students so that they can
respond.
I shall lead you to post news to a newsgroup. Follow the instructions below:
•
•
•

Start Net Scope Mail window
Select the newsgroup in the folder list
Click New Message button. What is on your window? Note that a News
composition window is displayed. Can you compare this with that for composing
e-mail? They are sure the same. Notice that your e-mail address will be
generated automatically.

This is the address other newsgroup users will use to send their replies to you.
•
•
•
•
•

Newsgroup *
Click the empty row under
Click on * to select Cc:
Type in your own e-mail address. What does Cc: mean? Of course you will get a
copy of the message to yourself.
Type in a heading for your message in that subject field
Click on
Send to post your news.

You have finally posted news to a newsgroup. Please repeat this activity as much as you
want until you have developed all the skills for this activity.

SELF-ASSESSMENT EXERCISE

Practise these skills on: browsing the NOUN homepage, using links in a webpage and
setting a browser default homepage.
What are the problems you have encountered?
1.
2.

What are the steps in setting up a newsgroup server?
How do you create and organise e-mail messages?

4.0

CONCLUSION

In this unit, you have created new mail folders. You have organised your mail messages.
You were able to set up newsgroup server. You have posted news to many newsgroups.
How did you do all these? If you had done all these activities effectively, your skills in
communicating through the e-mail have improved considerably.

5.0

SUMMARY

This unit has actually shown you the skills to create and organise new mail folders. You
have also developed the e-mails for setting up newsgroup server in your computer. You
have developed the necessary skills for posting news. The next unit will show you how to
reply to posted messages and sub-sending to a newsgroup.
Enjoy your Internet and WWW.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the steps involved in creating and organising new mail folders.
How will you set up a newsgroup server?
Describe the process of posting news to newsgroup.
Discuss the problems you have encountered in performing the activities and state
how they can be remedied.
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1.0

INTRODUCTION

In this unit, you will study input devices. Remember that in a microcomputer system,
data must be entered, processed, stored and produced as output.
What are input devices? This unit will discuss the means by which we enter data into a
computer system. Emphasis will be on the keyboard, mouse, optical scanners,
handwriting recognition and voice recognition input devices.
You will need to study this unit effectively and efficiently so that you can transfer the
knowledge gained here to other units in this course.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

describe the structure of the keyboard, mouse, optical scanners, handwriting and
voice recognition input devices
state the functions of the keyboard, mouse, optical scanners, handwriting and
voice recognition input devices
develop skills in the use of these input devices.

3.0

MAIN CONTENT

3.1

Keyboard

What is a keyboard? How does it work? You will learn to provide answers to these
questions later. Please read on.

Have you seen a typewriter before? Can you remember the parts? Please look at the
keyboard attached to your microcomputer. What are the differences between your
computer keyboard and the ordinary typewriters?
They are syntax in structure. However, the computer keyboard has a bank of numeric
keys on the right. It has a row of function keys at the top. It has an extra cursor and
movement keys in between the numeric keys and the Q – W – E – R –T –Y keys. You
should notice that there are 104 keys in the keyboard.
Please examine your keyboard and study these keys.
How does the keyboard operate? Can you guess? Remember that in the unit on
computer memory, we talked of computer reading information as a son’s of ones (1) and
zeros (0).
It is actually keys on the keyboard that convert the signals to these series when you press
the keys on the keyboard. The input software recognises the code and echoes the
associated character pattern into the display monitor. What you read on the screen are
the letters on the keys you just pressed.

Fig.1: A Keyboard

3.2

Mouse

What is a mouse? How does it operate? Are there other similar structures?
The mouse is an example of an input device. Can you remember that windows are a
Graphical User Interface (GUI)? What does this mean? Compare your answers with
mine below:
It means that you need a point-and-click device to operate it. The mouse is designed for
such a purpose.
Look at the mechanical structure of the mouse in Fig. 2:

Fig. 2: Mechanical Structure of a Mouse
Windows only need two buttons, other operating systems use three.
What can you observe? Note that a mouse has a rotating ball with sensors on the X- and
Y- axes. How does the mouse operate?
When the mouse moves horizontally, the ball rolls and activates the sensor on the X-axis.
This sensor generates corresponding signals to the PC to notify that there is mouse
movement in the X-direction. In a vertical movement, the sensor on the Y-axis is
activated and generates signals to the PC. The PC combines the signals from the X- and
Y- axes and understands the movement of the mouse in any direction.
How do you adjust your keyboard and mouse speeds? You can make adjustments to suit
how you want to use the keyboard and mouse. Simply follow the instructions to select
and set the different pads of these input devices.
•
•
•
•
•

Click on the start menu.
Select Settings and Control Panel.
Double click on the keyboard icon. What can you see? Note the keyboard
properties window. You can alter the delay and repeat rate of your keyboard.
Close the keyboard properties window.
Double click on the mouse icon. What do you observe? Note the mouse
properties window approach. This will allow you to change the double click
turning in the buttons menu. You can also change the cursor opened in the
Pointer options menu.

3.2.1 Touch Pad
What is a touch pad? How does it work?
A touch pad is a pressure sensitive pad that you can press on with your finger or with a
pen. When you press on the pad and drag, the result is similar to clicking a mouse
button and dragging. Track balls and touch pads are used mostly with notebook
computers because they are more compact and require less space to operate.

Touch Pad

Fig. 3: A Touch Pad

3.3

Optical Scanners

Remember that you can use the keyboard and mouse to enter new data directly into a
document. You can equally decide to copy an existing text or figure. This can take more
time and you may make mistakes.
There is an optical input device that can reduce such error and capture the data at
source. It is called optical scanner.
You can use the optical scanner to copy a text and photographs or other visual images in
your document by scanning them. There are two types of optical scanners:
•
•

Flatbed scanner
Sheet fed scanner

How do they operate?
In a flatbed scanner, you lay the image face down on the surface and use the software to
capture to capture or ‘acquire’ the image.
In a sheet fed scanner, you feed the document that you want into a carriage like you use
a fax machine. The PC that the scanner is attached to has a corresponding programme to
control the scanner option. You can use the photo-editing software to crop and edit
images.

Fig. 4: Optical Scanners

3.4

Handwriting Recognition Input Devices

How does this operate? What is it like?
Hand held computers have been developed because of handwriting recognition input
technology. It requires two hardware components:
•
•

a writing pad
a stylus

The stylus is an electronic pen. To use it you must install the handwriting recognition
software in the PC.
Sometimes this technology may not recognise everyone’s handwriting. To alleviate this
problem, the handwriting recognition software can automatically present a list of words
that it thinks is ‘close to’ what you have just written. The fine artists use a lot of this.

3.5

Voice Recognition Input Devices

What is this all about? How does it operate?
Voice recognition input device involves the ability of a machine or programme to receive
and interpret dictation, or to understand and carryout spoken commands . There are
two components in a voice recognition system:
•

the human voice must be converted into a digital form to enable it to be used in a
computer.
•
It must have a digital database of words for the computer to recognise input
voice.
To use this voice recognition input device, the PC needs to have a microphone and a
sound card installed along with the voice recognition software.
SELF-ASSESSMENT EXERCISE
i.
ii.
iii.

Examine your keyboard and mouse again. Try to recognise the keys. Type as
many things/words but you may need. Remember that your computer must be
one to do some of these activities.
Try to set the speed for your keyboard, mouse and cursor.
When next you visit a business centre, ask the operators to show you how an
optical scanner operates.

4.0

CONCLUSION

In this unit, you have studied the types of input devices. You have described their
structures and functions. You have also developed skills in using the keyboard keys and
the mouse. If you have studied these effectively you are getting ready to start word
processing.

5.0

SUMMARY

This unit has described the structures and functions of the keyboard, mouse, handwriting
recognition and voice recognition devices as input devices in a computer system. You
also studied the features of a trackball and a touch pad. If you have done all these
correctly, your study of the word processing unit of this course is in the right direction.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.
v.

Describe the input devices that a computer system can use to enter data.
State the major differences between a keyboard of a computer and an ordinary
typewriter.
Describe the operations of a mouse.
What are optical scanners?
Name the components of a handwriting input device.
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1.0

INTRODUCTION

In this unit, you will study output devices i.e. the means by which your computer system
presents you with information. We shall discuss display and printer technology
respectively. The structures and functions of these devices shall be studied in this unit.
You will need to study this unit effectively and efficiently so that you can transfer the
knowledge gained here to other units in this course.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

describe the output devices used in a computer system
state the components of the display and printer technology
describe the functions of the display and printer technology
print document from the computer system as stored.

3.0

MAIN CONTENT

3.1

Display Technology

The computer’s video (visual) display unit (VDU) is normally called the monitor or screen.
There are two display technologies used in PC systems:
•
•

CRT monitors
Flat panel monitors.

3.1.1 CRT Monitor Technology
What is the structure of the VDU? How does it operate?
You small TV in your house is similar to VDU used by most desktop computers.
It is based on a device called a Cathode Ray Tube (CRT). It is typically described as a
monitor.
CRT generates an electron beam. When this hits the phosphor-coated screen it will emit
light. This is the image seen on the screen. The CRT monitor is controlled by a display
card which is an adopter and inserted into one of the slots in the motherboard. The
display card and the CRT monitor work together to produce the image on the screen.
Can you describe the factors that can affect the quality of a computer screen? Compare
your answers with mine:
•
•
•

Size
Resolution
Colours.

Screen size
This is the size of the monitor measured in the same way as TV screen along its diagonal
length. The size ranges from 14” – 21”. There are some special screens designed for
specific applications e.g. A4 size screen designed for desktop publishing applications help
to design layout on A4.
Screen resolution
Screen resolution functions with the help of the display card. It determines in how much
detail the screen can display graphical information.
Each screen is made up of characters of small dots called ‘pixels’.
A pixel is derived from the words picture element. Pixels are the small dots of light that
are formed on the screen. The number of horizontal and vertical pixels on the screen
determines the resolution in the quality of the image.
For example, 800 x 600 resolution means that the screen can display 800 horizontal and
600 vertical pixels. The following resolutions are currently in use:
*

600 x 480

*
*
*
*
*

800 x 600
1024 x 768
1280 x 1024
1600 x 1200
2048 x 1536

Note that each pixel on the screen requires memory to hold the information. The
amount of memory required depends on the number of colours.
Screen colour
This determined the maximum number of different colours that can be displayed on the
screen. Remember that the human eye can see the primary colours. What are these?
Compare your answers with mine below:
Red, Green and Blue
When the basic colours are mixed with different intensities, it creates millions of
different colours. The number of colours available on a computer depends on how much
display memory the display card uses to store the colour values.
The most common colour standards are 256, 64K and 16M.
256 colour means that the computer uses 8 bits to store colour values that can produce
256 different colours on the screen.
64K colour means that the computer uses 16 bits to store colour values. This can
produce 65,536 combinations and is called high colour.
16M colour means that the computer uses 24 bits to store the colour values. It has 16
million combinations called true colour.
To support true colour, we need a PC with quite a lot of display memory. True colour
uses 24 bits to store one pixel. 1024 x 768 resolutions has 786,432 pixels. The total bits
required are 24 x 786,432 = 18.8 million bits or 2.3 MB display memory.
A display card needs to have more than 2.3 MB of RAM to support this. The traditional
display card comes with 4 M of RAM. Note that current display cards have 32 MB or 64
MB RAM on them. The additional memory is for 3-D graphics use. This will enable you
to see a three dimensional perspective on a two dimensional image.
3.1.2 Flat Panel Monitor Technology

Can you remember the advantages and disadvantages of CRT monitors? Please recall
that CRT monitors cost less and has good quality. However, they are bulky and consume
a lot of electricity. Therefore, notebooks cannot use them.
What then does the Notebook computer use as their monitors? Can you guess? Note
book computers use the flat pad monitor technology. What are the advantages and
disadvantages?
Flat panel monitor is light in weight, small in size and fugal in power consumption. The
price ratio between CRT and flat panel monitors has dropped significantly. Even desktop
PC systems are now using flat panel monitors.
Let me summarise the advantages and disadvantages of the different monitors for you in
Table 1:
Table 1:
Characteristics of CRT & Flat Panel Monitors
Characteristics
CRT Monitor
Flat Panel Monitor
Size and weight
Bulky,
heavy,
space Space saving, relatively light.
consuming.
Power consumption
Heavy, generates more Light, generate much less
heat.
heat.
Potential
viewing Can cause more fatigue No flicker problem. A better
problems
after prolonged viewing option if prolonged viewing is
due to flicker caused by needed.
electron beam scanning.
Price
Low cost.
Higher cost about x 4 more
expensive than a CRT of
comparable size.

3.2

Printer Technology

I am sure you have seen several printers at the business centres and in offices.
Remember that printer is one of the components of a computer system. What can it do?
What are the different types of printers? How do they operate? These questions shall
be answered shortly but read on.
Printers can produce the output from a computer on paper and transparencies. Printers
are different types:
•
•
•

Ink-jet printers
Laser printers
Dot-matrix printers

Each type of printer has different characteristics and is suitable for use in different
environments.
Let me summarise the printer specifications in Table 1.
Table 1:

Printer Specifications

Characteristics
Printing speed
Resolution
Cost

Colour Ink-Jet
8 ppm black
5 ppm colour
600 x 1200 dpi
N4,500.00

LaserJet
15 ppm (block only)
1200 api
N24,900.00

What can you observe from this table?
•
•
•

It shows that the major characteristics of printers are: speed (measured in pages
per minute or ppm). This will determine how fast you can have your printouts.
Resolution (measured in dots per inches dpi). This will determine the quality of
the printout.
Price will determine your taste and the amount of money to budget for.

How do these printers operate and function? We shall examine them in the next section.

3.2.1 Ink-Jet Printers
Ink–jet printers work by spraying ink from jet nozzles onto the paper. It can produce
colour images with multiple nozzles and different coloured mix. It has a high resolution
power (2880 dpi or higher) and so it can produce very high quality outputs. It can print
photo-quality images when special photo-papers are used.

Ink–jet printers are relatively slow and are expensive. It is suitable for low volume
printing at home and for personal use in offices. The ink cartridge can print a few
hundred papers before it can be replaced.
3.2.2 Laser Printers
Laser printers work by using a laser beam to draw an image on a metal drum. This drum
rotates across the toner which is attracted to the drawn image. A laser printer can
produce very high quality image because of the narrow beam and its accuracy.
Most laser printers are black and while. Laser printers are page printers (printing is page
by page as against line by line printing). They are fast. Laser printers can print several
pages per minute. They are used by large companies, e. g. big banks.
Laser printers use a toner cartridge that holds the powdered ink. A toner can print
thousands of pages before it can be replaced.
Which of these printers do you want to acquire?
3.2.3 Dot – Matrix Printers
This is the oldest type of printer. It works like a typewriter. It has a print head of 9 pins
(lower resolution) or 24 pins (higher resolution). It strikes a printer ribbon and makes an
impression on the paper.
Dot – matrix printers are simple and reliable but can only produce low quality output.
The printer ribbon is inexpensive and the cost per page is the lowest of all the printer
types.
Dot – matrix printers work by impact – printing and produce an annoying nine when they
print. Most business centres do not use them any longer.

Fig. 1:

Dot – Matrix Printers

SELF-ASSESSMENT EXERCISE
1.

What is the memory capacity of a true colour PC?

2.
3.

If you had to choose a display unit for your PC, which one will you choose and
why?
What are the major advantages of an Ink–jet over the LaserJet printers?

4.0

CONCLUSION

In this unit, you have studied the types of output devices of a PC system. You have
described their components and functions of the output devices of a PC system. You
have described the characteristics of these output devices. You have selected one of
these output devices for your acquisition. I hope you made a wise decision.
Congratulations!

5.0

SUMMARY

In this unit, types of output devices were referred to as display and print technologies
respectively. Display technology consists of VDU generally referred to as monitors or
screens. The CRT and flat panel monitors were discussed in terms of size, resolution and
colour. The advantages and disadvantages of these VDU were discussed.
Print technology consists of ink – jet, laserJet and dot – matrix printers respectively. The
characteristics of these printers were discussed in terms of speed (ppm) and resolution
(dpi). The advantages and disadvantages were discussed.
I hope you had studied this section effectively so that you can start to print when you will
study word processing in the next units.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.
v.

Describe the types of output devices in a PC system.
Discuss the advantages of a CRT monitor over a flat panel monitor.
Describe the disadvantages of an ink–jet over the laserjet printer.
Describe how an ink – jet printer operates.
Provide complete words for this abbreviations:
ppm, dpi and pixel.
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1.0

INTRODUCTION

In this unit, you are going to develop skills on how to operate word document. You will
be involved in several applications and activities. These will include:
Creating and saving document, opening an existing word document and printing a word
document.
These activities and applications are designed to become more proficient in word
processing your word documents.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•

create and save a word document
open an existing word document

•
•

print a word document
develop appropriate skills to perform these activities using your own PC.

3.0

MAIN CONTENT

3.1

Creating and Saving a Word Document

How do you create a word document? How do you save a word document?
You can perform these activities very well if you will follow the instructions listed below.
You will need your computer to perform these activities.
•
•
•
•

Start Word 2000/98 by going to the task bar
Select start button
\\\\ Start
Select programmes
W Microsoft word
Select Microsoft word

What do you observe? Note that there is a new blank document. There is the word
‘Document1’ in the document’s title bar.
There is also a blinking insertion point on the new blank document. Of course, when you
begin to type the text will appear at that insertion point.
•
•
•

•
•
•

Type some text. Did you make any mistake? Do not worry for it is normal for
beginners like you. You will correct them later in this course.
Use your mouse to open the File menu. Note that this is at the top of the screen.
Select save. Have you observed any additions? Notice that A Save As window
appears but the file and directory names are different. It is important for you to
save the current drive.
Click ∆ 3 ½ Floppy (A)
∆

•
•

Type an appropriate name to save your document, e.g. exams.
Click the Save button. Notice that ‘exams’ replaces ‘Document1’ (the default File
name).
Select File from the menu.
Click close to close ‘Exams doc’.

3.2

Opening an Existing Word Document

Can you perform this activity? Follow the instructions below:
•

Select the File menu

•
•
•
•

Click on Opening
Select drive C :
Click on ‘Exams doc’ that you want to retrieve
Click the Open ….. button.

What can you observe? The contents of ‘Exams doc’ will appear on the screen. This is
ready for printing.

3.3

Printing a Word Document

How do you perform this activity? Follow the instructions. But be sure that your printer
is properly connected to your computer and is switched on. Can you guess why this must
be done so? If you do not observe these simple rules you cannot print anything because
the printer will not be activated.
•
•

Select the File menu
Click on Print … to print the document you have opened. What do you observe?
There is a Print dialog box shown. If your printer is set properly, it should print the
document. You must be a very happy person now! Just relax because this is the
beginning stages of word processing.

SELF-ASSESSMENT EXERCISE
Practise all these activities by following all the necessary instructions.

4.0

CONCLUSION

In this unit, you have created and saved a word document. You opened an existing word
document. You have printed a word document. You are doing very fine for now if you
have performed these activities correctly.

5.0

SUMMARY

This unit has shown you how to create and save a word document. It has shown you
how to open an existing word document. You have equally printed a word document.
You have developed the appropriate skills for these activities. Your knowledge and skill
for word processing of document have increased gradually. The next units will
consolidate all these.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.

Describe the processes and steps in creating and saving a word document.
State the steps needed to open a word document and print a word document.
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1.0

INTRODUCTION

In this unit, you will continue to develop further skills in word processing of word
document. You will create another document. You will insert text and overtype. You
will use Office Assistant. I hope you did practise more of the previous units. Once again,
you will work with your computer.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

create another document
insert a text and overtype on it
use the Office Assistant
develop skills in the performance of these activities.

3.0

MAIN CONTENT

3.1

Creating another Document

How do you create another document? Remember that in the last unit, you were able to
create and save a Word document. Can you remember precisely what you did?
This section will help you further in studying word processing by creating another
document. Please follow the instructions carefully and you can achieve your efforts.
Now the following:
•

Click on the File menu

•
•
•
•

Select New …. What do you observe? A new window will pop up.
Click on the Blank Document icon
Click OK
Save the new file. I know that you can still remember the commands of naming
and saving a word document. If you do have problems, please refer to unit 1.
Read through the steps again.

3.2

Text Insertion and Overtype

Can you carryout this activity? It is very easy and it is one of those activities you will be
performing most of the time.
Please follow the instructions carefully to perform this activity:
•
•
•
•

•
•
•

•

3.3

Type some text in a word document
Use your mouse to point the cursor to any part of your text
Click the left mouse button
Start typing some more text. What can you observe? Note that all the text to the
right of the cursor has shifted forward. The text you are typing is inserted into
your document at the cursor’s current position. We call this text insertion. Please
repeat this activity by typing a new text and following the instructions to perform
text insertion. Have you done this successfully? Now perform this other activity
below.
Click the left mouse button
Press the <insert> key
Start typing. What do you observe? You will find that what you have typed is
overwriting your existing text. We call this overtype mode. You can switch
between overtype mode and insertion mode. How can you perform this?
Press <insert> key once again. You will be performing this activity most of the
time. Please perform this activity several times to be sure that you have
perfection. Have you done it? Then you have acquired the necessary skills.
Congratulations!

Using the Office Assistant

We are not referring to any office assistant in your office! So do not worry yourself so
much for now. We are referring to the Office Assistant in word processing.
Has your Office Assistant shown up since you started the activities of this course? Do the
following to wake it up!
•
Double click on Office Assistant. It will ask you: What would you like to do? It will
provide you with activities.
•
Type in your question in the content box.
•
Click Search after typing. What can you observe? Another dialog box will appear.

•

Select what to do from the sensual suggestions given.

Note that Office Assistant will show up anytime you may need a help in word processing.
Practise more on this activity.
SELF-ASSESSMENT EXERCISE
1.
2.

Practise how to insert text, and overtype several times.
What are the problems you have noticed?

4.0

CONCLUSION

In this unit, you have just been introduced to basic word processing skills of creating
another document. You have performed the text insertion and overtype activities. How
did you perform all these? Did you carry out all the instructions that the Office Assistant
provided for you? If you performed these activities carefully and successfully, you are in
the right direction to study more of skills in word processing.

5.0

SUMMARY

This unit has shown you the skills of creating another document. It has shown you how
to carryout text insertion and use of the Office Assistant. In the next units we shall show
you how to develop more skills in word processing. Be a little patient please!

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

Describe the steps you will follow to create another document.
Discuss fully how you can insert on text and overtype if needed by your client.
State the problems you can encounter and provide solutions to these problems.

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.
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1.0

INTRODUCTION

In this unit, you will be performing more skills in word processing. You will be introduced
to moving and copying texts. You will move and copy text using the ‘drag-and-drop’
method. You will change fonts and apply effects. Please read on.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

move and copy text
move and copy text with the ‘drag-and-drop’
change fonts
apply effects.

3.0

MAIN CONTENT

3.1

Moving and Copy Text

How do you perform this activity? What are the skills needed to perform this activity?
Please follow the instructions below to carry out this activity successfully:
•
•
•
•
•
•
•
•
•

Create a document
Type some text in a paragraph form
Press <Enter> when you have finished the paragraph
Select the first sentence of that paragraph
Highlight it with the cursor
Select Cut from the standard toolbar
Move the cursor to the end of the paragraph
Select
Paste in the standard toolbar. What can you observe? Notice that
the first sentence of the original text has now moved to the end
Copy in
the standard toolbar.
move the cursor to a line below the paragraph

•

Select Paste button. What can you observe? You should notice that your entire
text has been rewritten in the order that you want. Please practise this activity
again using different texts. Please note the problems that you have encountered.

3.2

Moving and Copying Text with ‘Drag-and-Drop'

Let us introduce you into a new skill of moving and copying a text. Please follow the
instructions below:
•
•
•
•
•
•
•

•
•
•
•
•

Create a document in a paragraph form
Highlight the second sentence
Delete that sentence
Select Cut button
Select the last sentence in the paragraph
Hold down the left mouse button while you drag the text to the beginning of the
paragraph. What can you observe so far? Note that there is a box with a dotted
border attaching itself to the mouse pointer.
Release the mouse button. What can you observe? The text will be pasted at the
insertion point. Note that the sentence order of the original paragraph is now
restored.
Select the entire paragraph
Hold down the < Ctrl > key on your keyboard
Drag the text to its new location. What can you observe? Notice that a box with a
plus sign attached to the mouse pointer shows up.
Continue to hold down the key < Cont >
Release the mouse button. What do you observe? The text will be pasted at the
insertion point. Note that the original text will remain where it was. This is dragand-drop moving and copy of text.

Practise this activity attain.

3.3

Changing Fonts and Applying Effects

Can you perform this activity? Follow the instructions below:
•
Use the word file you created in the previous activity
•
Change the font of the first paragraph Arid
•
Set the font size to 12 points
•
In the first paragraph, apply the following effects one by one to the first 6 words
and all others after.
i.
ii.
iii.

Strike through
Double strike through
Superscript

iv.
v.
vi.
vii.
viii.
ix.
x.

Subscript
Shadow
Outline
Emboss
Engrave
Small caps
All caps

Write down your observation in each case.
SELF-ASSESSMENT EXERCISE
i.
ii.
iii.
iv.

Practise moving and copying any text that you have created.
Use the drag-and-drop method to move and copy some paragraph of your new
text.
State the difficulties you have experienced in carrying out these activities.
Practise more of these activities at your own time schedule.

4.0

CONCLUSION

You have moved and copied text. You have used the drag-and-drop method to move
and copy text. You have changed the fonts and applied effects on your document. If you
have done all these activities successfully you have studied this unit very well. However,
you will need to spend some more time on your own if you had some problems in
performing these activities.

5.0

SUMMARY

This unit has shown you how to change fonts and apply effects to your text. You have
also used the drag-and-drop method to move and copy document. You finally succeeded
in moving and copying your text and document freely. Your knowledge and skills in word
processing have increased considerably. The next units will bring more perfection for
you.

6.0

TUTOR-MARKED ASSIGNMENT

i.

iii.

Discuss the steps needed to move and copy a text with the drag-and-drop
method.
Describe the problems you have encountered in performing the first activity in
question 1.
Practise all these activities at your own schedule.

7.0

REFERENCE/FURTHER READING

ii.

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.
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1.0

INTRODUCTION

In this unit, you will be study the changing views in Word 2000. You will justify and use
tabs. You will define headers and footers. These are all activities that will provide you
with further skills to become more proficient in word processing.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•
•

change the current view to different modes in Word 2000
justify text
use tabs to space and align them correctly
define headers and footers
develop further skills in word processing.

3.0

MAIN CONTENT

3.1

Changing Views in Word 2000

Can you perform this activity? If not, please follow the instructions below:
•
•

Retrieve the document you used to move and copy text in the previous unit.
Did you save it correctly? If you did save it correctly then you should have no
problem retrieving it.

•

Change the current view to different modes of your choice. What can you
observe? Which of these words do you prefer and why? Repeat this activity as
much as you can.

3.2

Justifying Text and Using Tabs

In justifying your text that you created in the previous unit, you will need to do the
following:
•
•

Highlight the paragraph
Select the Justify button. What do you observe? Notice that the whole paragraph
has become justified.

Practise this activity several times. You will need this skill in most of your activities.
•
•
•

Type some figures in a table
Use the tabs to space them
Align them by selecting the align button on the toolbar.

Practise this further.

3.3

Defining Headers and Footers

Retrieve the document in unit 3 for this activity:
•
•
•
•

Type your name in the header
Type the date in the header too
Type the file name in the footer
Type the page number in the footer of this document.

SELF-ASSESSMENT EXERCISE
1.

Practise these activities several times.

4.0

CONCLUSION

In this unit you have been able to change the views in Word 2000. You were able to
justify text and used tabs to align them correctly. You address your name and date in the
header. You also added the file name and page number to the footer of your document.
You have developed further skills in word processing by performing these activities. Well
done if you did them correctly.

5.0

SUMMARY

This unit has shown you how to change the views of Word 2000 to different modes. It
also showed the skills to justify your text, space and align correctly using the tabs. You
have been able to add your name and date to the header and file name and page
number to the footer. You are progressing gradually towards the understanding more of
the skills in word processing.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

Discuss the steps in justifying a text.
How would you change the different views in Word 2000 of your document to
different modes?
Discuss the problems associated with the performance of these activities.

7.0

REFERENCE/FURTHER READING

Open University of Hong Kong (2001). Foundation in Microcomputing & WWW. ETPU
Publishers.
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1.0

INTRODUCTION

In this unit, you will learn to develop skills in word processing by inserting pictures into a
word document. You will also develop skills in checking spelling and grammar. You will
work with tables.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

insert pictures in a word document
check spelling and grammar in a word document
work with tables in a given word document
develop more skills in handling these activities.

3.0

MAIN CONTENT

3.1

Inserting Pictures

How do you perform this activity? Please follow the instructions below to carry out this
activity successfully:
•
•
•

Retrieve your document in unit 3
Make a page break in this document
Locate this clip out object
 in the clip gallery

•

Insert this into the document.

3.2

Checking Spelling and Grammar

Please follow the instructions below:
•
•
•
•

Go to the Tools menu
Select Spelling and Grammar ….
Run the spell check through your saved document of unit 3
Click the grammar box too to check your grammar. Did you make any spelling or
grammar mistakes? Hence your corrected them?

Type more text and check the spelling and grammar. At the end your skills in checking
spelling and grammar mistakes should have improved.

3.3

Working with Tables

Can you perform this activity CORRECTLY? Follow the instructions presented below to
perform this activity:
•
•
•
•
•

Select the File menu
Click on New …. To open a new word document
Click on the Insert Table button
in the standard toolbar
Drag your mouse to cover five squares across and three down
Release the mouse button.

What have you observed? A five column and a three row table can be formed for you.
•
•
•
•
•
•

Name the table “students performance by subjects”. You can increase the
columns of your table. How do you perform this?
Go to the View menu
Select Toolbars
Click on Tables and Borders to bring up the Tables and Borders toolbar
Drag your mouse down the last column of this table
Click on the split calls button. What can you observe?

Notice that the Split Cells dialog box appears showing two columns and three rows:
•
•
•
•
•

Click OK. Note that the last column has been split into two
Drag your mouse to select the whole table
Click the Distribute Columns Evenly button on the Tables and Borders toolbar
Fill in the rest of the table with appropriate data on students’ performances and
subjects. Can you insert/create a title for the table?
Position the insertion point anywhere in the top row

•
•
•
•
•
•
•
•
•
•
•

Select the Table option in the main menu to insert a row above the top row
Drag your mouse to select the entire top row.
Click the Merge Cells button
Type “Students Performances by Subjects”
Type the data with the Table that you have created
Use different visual layouts for the table
Change font/size
Make it bold
Change font to Arial
Set heading at 14 point while the rest of the text is 10 point. You can use the
formatting toolbar to change the font size and type
Try also selecting View ⇒ Toolbars ⇒ Formatting in the menu if the toolbar
becomes inactive.

Can you provide borders for your table? How do you perform this?
•
•
•
•
•
•
•
•

Select the whole table
Click Border box from the Tables and Borders toolbar
Click no Border
Select Outside Border
Select shading colour button to add some effects
Select a row that you want to colour
Click on shading colour button. What do you observe? Notice the appearance of
the colour pallet.
Select the colour that you like. What can you observe? Note that your selected
colour will change correspondingly.

At this point in time you should notice that your table has been produced. This activity
seems a bit difficult. Please read through the instructions again. Perform this activity
carefully
SELF-ASSESSMENT EXERCISE
i.
ii.
iii.
iv.

Create any table of your choice.
Increase the columns and rows by 3 and 2 respectively.
Provide a title for the table.
Shade some sections.

4.0

CONCLUSION

In this unit, you were able to check spelling and grammar in your document. You were
able to add pictures. You were shown how to create a table, add columns and rows as
well as titles. If you did perform the skills needed for all these activities correctly, then
you have learned a lot about word processing.

5.0

SUMMARY

This unit has strengthened your knowledge and skills of word processing. You have
studied how to create tables, add more rows and columns, add effects like shading. You
have developed skills to check spelling and grammar. You have developed skills to insert
pictures. You have become proficient in the use of word processing technique to
developing a word document. You have done very well. Congratulations!

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the steps and processes of adding a picture to a document.
Discuss the steps in creating a table and inserting it in a word document.
State the problems/difficulties in carrying out these activities.
Practise more of these activities at your own free schedule.

7.0

REFERENCE/FURTHER READING
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1.0

INTRODUCTION

In this unit, you will be studying the types of connectors, sockets and connectors that
your PC requires in order to operate effectively.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

describe the types of connectors
identify the connectors of a PC
describe the sockets that are used for the connectors.

3.0

MAIN CONTENT

3.1

Types of Connectors

By now you should remember that the input and output devices are external to the PC
system box. Similarly, you will recall that the adapter cards, hard disk and motherboard
are inside the PC system box.
How are these linked together for the computer to operate? They must be connected by
cables and connectors through the various connection ports at the back of the PC.
What is a port?
It is the ‘information doorway’ that allows information to flow between a computer and
external devices. It was a predefined protocol to control the flow.
The types of connectors are presented below:
1.

AT keyboard – DIN5

This is the oldest PC keyboard connector designed for PCs in the 1980s.
2.

PS / 2

A smaller connector designed originally in IBM PS / 2 PCs for connecting keyboard and
mouse.
3.

Serial

Both the 9 – pin and 25 – pin serial ports are industrial standard. Most PCs have both,
and one is designated as COM 1 and another COM 2.
4.

Parallel

Mainly for printers but some low – end devices e.g. scanners and zip driver also make use
of it. It has 8 pins to transfer data in parallel so the transfer rate is faster than a serial
port.
5.

Small Computer System Interface – SCSI

A high–speed (up to 40 MB per second) interface to connect storage devices or other
devices that have a large volume of data transfer.
6.

Video

A 15 pin connection designed for connecting CRT monitors.

7.

USB – Universal Serial Bus

It replaces all the different kinds of serial and parallel port connectors with one
standardized plug and port combination.
8.
IEEE 1394 bus called Fire wire. The Sony Corporation markets it as I – link.
3.2

Sockets

What are the sockets used for these connectors? How are they connected?
I shall present them below:
1.

For DIN 5

2.

PS / 2

the socket looks like this


3.

Serial
25 pin

4.

Parallel

5.

SCSI

6.

VIDEO

7.

USB

9 – pin

8.

I E E E 1394 Bus

You will need to handle these sockets physically to appreciate their structure.

3.3

Connectors

Please examine them physically to see the major differences.
1.

AT Keyboard – DIN5
(Keyboard)

2.

PS / 2
(Keyboard, Mouse)

3.

Serial
(Mouse, Modem Digitizer)

4.

Parallel
(Printer, Low-end Scanner)

5.

SCSI
(External Hard Disk, CD – R, CD – RW, Scanner)

6.

VIDEO
(CRT Monitor)

7.

USB
(Scanner, Printer, Digital cam, Keyboard)

SELF-ASSESSMENT EXERCISE
1.
2.
3.
4.

Examine the sockets and connectors.
State the differences between the connectors and sockets.
Can you identify them?
Name the corresponding output and input devices for these connectors and
sockets.

4.0

CONCLUSION

In this unit you have been able to differentiate between a socket and a connector. You
have been able to match the input and output devices to the corresponding connectors
and pockets respectively.
Perhaps, you will need to handle them physically to see the differences. Invite your
technician if you are in doubt. You will need to read the manuscript and users guide that
accompanied your computer.

5.0

SUMMARY

This unit has shown you the different types of connectors (DIN 5, PS / 2, Serial, Parallel, S
C S I, Video, U S B, IEEE 1394). You have studied the ports and sockets. You have
identified the different output and input devices that these connectors and sockets use.
Your study of microcomputing has progressed successfully if you studied this unit
carefully.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the types of connectors and their corresponding output and input
devices.
State the differences between a parallel and serial connector.
Name the corresponding input and output devices for the connectors and sockets.
Examine the connectors and sockets closely. Try to identify them.

7.0

REFERENCE/FURTHER READING
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Publishers.
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1.0

INTRODUCTION

You have studied the hyperlinks in EDT 702, Introduction to the Internet. What is a
hyperlink? You will need to think about this again if you still have any problem.
In this unit, we shall discuss the process of adding hyperlinks in FrontPage. You will
develop the skills for adding an e-mail link in FrontPage. This will further help your
understanding of authoring of Webpage.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

add hyperlinks in FrontPage
add an e-mail link in FrontPage
develop skills in performing these activities.

3.0

MAIN CONTENT

3.1

Adding Hyperlinks in FrontPage

How do you perform this activity? What skills do you need to achieve this?
Please follow the instructions below:
•
•
•
•

Go to the FrontPage menu
Select File
Select Open …
Open the file you saved in unit 2

•
•
•
•

Click on NOU logo at the top to select it
Go to the menu
Select Insert
Select Hyperlink … What can you observe?

Note that the created Hyperlink window will appear.
•

Enter the URL for NOU homepage
URL:

•
•
•

http://www.noun.edu.ng/

∇

Go to the menu
Select File
Select Save As ….

Note that a Save As window will appear
•
•
•

Name the file as appropriate
Click on Save
Click on the Preview tab to view your webpage. What can you observe? You will
notice the cursor will show a pointing hand over the NOU logo.

3.2

Adding an E-Mail Link in FrontPage

Can you develop the needed skills for this activity? Follow the instructions below.
•
•
•
•
•
•
•
•

Go to the FrontPage menu
Select File
Select Open …
Open the file you had saved in 3.0
Click on the mail icon on the bottom of the page to select it.
Go to the menu
Select Insert
Select Hyperlink …

Note that the Create Hyperlink window will come up.
•

Click on the envelope icon on the right of the URL: field.

Can you observe anything? Note that A Create E-mail Hyperlink dialog box will appear.

•
•

Enter the e-mail address gib@noun.edu.ng in the address field
Click OK.

Note that the e-mail address is not real. It is a way of getting you to study this section.
•
•
•
•
•
•

Go to the menu
Select File
Select Save As … Note that a Save As window will appear
Name the file
Click on Save
Click on the Preview tab to view your webpage.

Have you observed that as you move the mouse over the mail logo, the cursor changes
to a pointing head?
If your PC is connected to the Internet, as you click on the mail icon, you will bring up
your PC’s e-mail composer with the recipient’s address already entered.
SELF-ASSESSMENT EXERCISE
Practise these activities again to become efficient.

4.0

CONCLUSION

In this unit, you have added hyperlinks in FrontPage. You have also added an e-mail link
in FrontPage. I hope that you have learned the appropriate skills for performing these
activities.

5.0

SUMMARY

You have learned to develop skills for adding hyperlinks in FrontPage. You have
developed skills for adding an e-mail link in FrontPage. If you have done these activities
carefully and successfully, you would have been ready to author a webpage. Please
practise these activities to show proficiency in the needed skills for these activities.
Congratulations!

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the procedure for adding hyperlinks in FrontPage.
How would you add an e-mail link in FrontPage?
What are the problems of performing these activities?
Practise more of these activities to reduce these problems.

7.0

REFERENCE/FURTHER READING
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1.0

INTRODUCTION

In this unit you will learn to use FrontPage to add form component. You will study how
to create and save a new page in Dreamweaver. Your knowledge f authoring a webpage
is increasing.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

use FrontPage to add form components
create a new page in Dreamweaver
save a new page in Dreamweaver
develop skills in performing these activities.

3.0

MAIN CONTENT

3.1

Using FrontPage to Add Form Components

How can you do this activity?
Follow the instructions below:
•
•
•

Click on the start button of the window taskbar to bring up the start menu
Select Programmes
Select Microsoft FrontPage.

Note that the FrontPage 2000 workplace appears.
•
Select File
•
Select New
•
Select Page … Can you observe the new window?
•
Accept the default selection Normal Page
•
Click on the OK button
•
Type the heading 2002/2003 Abuja Prospectus Request Form
•
Format the font to a large size
•
Bold it
•
Select Insert
•
Select Horizontal Line.
Note that the Horizontal line becomes inserted.
•
•
•
•

Place the cursor under the line
Go to the menu bar
Select Insert
Select Form.

Note that a form component will appear.
•

Press the < Enter > key once.

Note that more spaces are created for you to enter more components.
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Move the cursor to the top of the form
Type in the line. Please enter your Name and Address
Apply some formatting
Start a new line
Go to the menu bar
Select Insert
Select Form
Select Scrolling Text Box
Click on the text box to reveal its handles
Resize the text box
Go to the menu
Select File
Select Save As … Can you see the Save As window?
Name the file appropriately
Click on the Save button
Click on the Preview tab to view your webpage
Type your name and address into the text box.

3.2

Creating and Saving a New Page in Dreamweaver

Let us present the instructions on how to perform this activity.
•
•
•
•

Bring up the start menu by clicking on the start button of the windows taskbar
Select Programmes
Select Macromedia Dreamweaver 3
Select Dreamweaver.

Note that the Dreamweaver workplace appears. In the Document Window, enter the
following:
GIB’s Homepage
Welcome to GIB’s Website
EDT 703 Microcomputing & WWW
•
•
•
•
•
•
•
•

Select Window
Select Properties
Click and drag the cursor to select the line ‘GIB Homepage’
Go to the Properties Launcher
Change the size to 5
Select all the lines
Go to the Properties Launcher
Click on
to apply bolding to the lines of text
B

•

Select : EDT 703

•
•
•
•
•
•
•
•

Go to the Properties Launcher
Click on the Unordered List icon
Apply bullet to the lines of text. Add a title to the Document window
Go to the menu
Select Modify
Select Page Properties … Note that the Page Properties window appears.
Type Dreamweaver Activity in the Title: field.
Click OK.

Microcomputing & WWW

Can you save this document? Follow these instructions:
•
•
•

Go to the menu
Select File
Select Save …

Note that Save As window. Use the ‘My Web’ sub-folder under ‘My Document’ to store
this webpage.
Name the file appropriately. Study your Document window as presented after you have
successfully completed the steps of this activity
SELF-ASSESSMENT EXERCISE
i.
ii.

Describe the steps to use in creating and saving a new page in Dreamweaver.
Practise the skills on how to use FrontPage to add form components.

4.0

CONCLUSION

In this unit, you have used FrontPage to add form components. You have created and
saved a new page in Dreamweaver. You have successfully developed skills to perform
these activities. The next unit will provide more activities for authoring your web page.

5.0

SUMMARY

This unit has helped you to develop skills in using FrontPage to add form components.
You have developed skills to create and save a new page in Dreamweaver. You are doing
quite fine. Your study of the next unit will perfect your web authoring. Congratulations!

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the procedures for using FrontPage to add form components.
Discuss the steps needed to create and save a new page in Dreamweaver.
Discuss the difficulties if any in performing these activities.
Practise more on these activities.

7.0
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1.0

INTRODUCTION

In the last unit of this module, you did create and save a new page in Dreamweaver. I
hope you did that successfully.
In this unit, you will add images in Dreamweaver. You will also develop skills in adding
tables in Dreamweaver. Besides this activity, you will add links in Dreamweaver. Please
read on.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

add images in Dreamweaver
add tables in Dreamweaver
add links in Dreamweaver
develop skills to perform these activities.

3.0

MAIN CONTENT

3.1

Adding Images in Dreamweaver

How do you perform this activity?
Please follow the instructions below: Remember that the course CD has a folder, Media
Files. There are five image files and two sound files.

In order for you to add images in Dreamweaver, you will need to access the media file
folder. Follow these instructions to perform this activity.
•
Double click on the My Computer icon on the desktop
•
Right click on the CD – ROM drive icon
•
Select Open
•
Double click on the ‘Media File’
•
Copy the ‘Abuja.gif’ file from the media file into a folder on your PC
•
Go to the Dreamweaver Document window menu
•
Select File
•
Select Open …
•
Open the file you saved in unit 4 (3.1)
•
Insert a blank line above the line GIB Home page
•
Anchor the cursor at the beginning of the line
•
Press < Enter > once
•
Anchor the cursor at the top right hand corner of the Document window
•
Go to the Objects Palette
•
Click o the Insert Image icon.
Sometimes you may find that the objects palette is on your screen already. You need to
do the following:
•
•

Select Window
Select Objects.

Can you observe the Select Image Sources window on your screen?
•
•
•
•

Select ‘Abuja.gif’ file from your PC
Go the menu
Select File
Select Save As ..

Can you observe the Save As window?
•
•

Name the file as appropriate
Click Save in the ‘My Web’ Sub-folder of ‘My Documents’.

You should observe a screen that shows your Document window. If you do have
difficulties please go over this activity step by step until you are satisfied.

3.2

Adding Tables in Dreamweaver

Follow the instructions to perform this activity.

•
•
•
•
•
•
•
•

Go to the Dreamweaver Document window menu
Select File
Select Open … to open the file you have saved in 3.0
Select Window
Select Objects
Place the cursor under the line EDT 703 Microcomputing & WWW
Go to the Insert Table icon in the Object palette. Can you observe the Insert Table
dialog box?
Set the size of the table to:

Rows
Columns
•
•
•
•
•
•
•
•
•
•
•

3
2

Click OK
Enter the content into the table. Note that the table will show the semester the
course will be offered.
Press < Enter > once. Note that the column width will adjust automatically
Select the table by clicking-and-dragging it
Apply the bold button.
Apply the italic button
Go to the menu
Select File
Select Save As … Note the appearance of a Save As window
Name the file appropriately
Click on Save button to save it into ‘My Web’ sub-folder of ‘My Documents’.

Can you observe a screen that shows your Document window? If you are not satisfied,
you can repeat this activity until you are sure of the actual window.

3.3

Adding Links in Dreamweaver

Follow the instructions below to perform this activity:
•
•
•
•

Select File from the Dreamweaver document window menu
Select Open .. to open the saved file in 3.1 activity
Select Window
Select Properties.

You are ready to add a link to the line:
EDT 703 Microcomputing & WWW

•
•
•

Select EDT 703
Go to the Property Inspector
Click on the Browse for file icon on the right of the link field.

Note that a select window will come up
•
•
•
•
•
•

Select the target file in the URL.
Go to the menu
Select File
Select Save As .. As usual a Save As window appears.
Name the file appropriately
Click on Save.

This will be saved into the ‘My Web’ sub-folder of ‘My Documents’. Please ensure that
as the cursor moves to EDT 703 text; it changes to a printing hand. This is the link added
to the Dreamweaver.
These activities may seem a bit confusing. Please repeat them as many times as your
schedule can permit.
SELF-ASSESSMENT EXERCISE
i.
ii.

Practise these activities in this unit several times.
Discuss any difficulties in the process.

4.0

CONCLUSION

In this unit, you studied how to add images in Dreamweaver. You practised how to add
tables in Dreamweaver. You added links to Dreamweaver. You developed skills in
performing these activities. Did you find it easy? I guess you will need to practise more
of these activities.

5.0

SUMMARY

You have developed skills in performing activities in the Dreamweaver. You have added
images. You added tables and you also added links.
By now your efficiency in authoring web pages has increased considerably. Your study of
this unit will increase your knowledge and skills in the study of subsequent units. Well
done.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

Describe the steps needed to add images to Dreamweaver.
Discuss the process of adding tables in Dreamweaver.
How will you add links in Dreamweaver?
Discuss the problems and difficulties you experienced in performing these
activities.
Carry out any of these activities that you do not really feel comfortable
performing.

v.

7.0
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1.0

INTRODUCTION

I am sure that you have been hearing of music CD, a CD – ROM movie, and a DVD movie.
Your PC can play any of these. In some instances, your PC can be used for broadcast
media like radio. A PC that can be used to play both audio and video is called a
multimedia PC.
Multimedia applications can integrate text, pictures, motion pictures, animated graphics
and sound. Therefore, a PC can serve as a working tool and an entertainment medium.
In this unit, you will study the different types of multimedia hardware. Specifically, you
will discuss multimedia applications as these relate to: CPU, CD – ROM / DVD drive,
Sound Card, Graphic Card, Display Monitor and Editors. Please be ready.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

describe types of multimedia hardware
discuss the structure of multimedia hardware
describe the functions of multimedia hardware
discuss their applications.

3.0

MAIN CONTENT

3.1

The Central Processing Unit (CPU)

What is this? How does it work? What does it support? These questions will be
discussed shortly.
CPU supports multimedia extension – MMX. Please note that video and sound files are
much larger than text files. A lot of processing power is required to process sound and
video files.
MMX is a special set of CPU instruments that is optimized for handling multimedia files.
It can therefore be used to improve the overall performance of a multimedia PC.
Please follow the instructions below: Remember that the course CD has a folder, Media
Files. There are five image files and two sound files. In order for you to add images in
Dreamweaver, you will need to access the media file folder. Follow these instructions to
perform this activity.

3.2

A CD – ROM or DVD Drive

You can recollect that we had discussed CD – ROM and DVD drive as storage devices for
the computer. Can you remember the computer memory? Please read through the
units on storage devices and computer memory again if you have forgotten.
For now please note that multimedia files are very large and are generally stored on CD –
ROMs and DVDs.

3.3

Sound Card, Speaker and Microphone

Can you remember the adapter cards that are inserted on the motherboard of your
computer? A sound card is one of those adapter cards. What is it and how does it
operate?
A sound card is a small circuit board inserted into the PC’s motherboard. It has an input
part that can be plugged into a microphone. It also has an output port for plugging in a
pair of speakers and hand phones. The sound card can guarantee the quality of the
sound to be produced.

3.4

Graphic Card and Display Monitor

Most PCs require fast graphic card to process the large amount of graphics produced in
multimedia applications. Each graphic card must have sufficient memory e.g. 4 M to
support high – resolution (1024 x 768) and high – colour / true colour.
The display monitor should be larger and of a higher quality in order to produce vivid
images on the screen.

3.5

Editing Platforms

What are these? What can they do?
Some powerful PCs can function as an editing platform besides playing multimedia files.
You need a video camera along with its associated capture card to supply the source file.
High quality pictures are usually connected to a DV camera. You also need a CD – RW or
DVD RAM drive. You also need to have a large capacity hard disk for the editors to work.
SELF-ASSESSMENT EXERCISE
i.
ii.

Examine the several multimedia hardware at your disposal.
Discuss their structure and functions.

4.0

CONCLUSION

In this unit, you have studied the different multimedia hardware that your PC can use.
You have described them. You have studied their functions where applicable. You will
need to examine them again.

5.0

SUMMARY

You now know that MMX is a special set of CPU instructions for handling multimedia
files. You know that multimedia files are stored on CD – ROMs/DVDs. You have known

that sound card is used as input part for plugging microphone and output port for
plugging speakers and hand phones.
You have known that a PC that can play both audio and video is called a multimedia PC.
Such a PC can integrate text, pictures, animated graphics, sound and motion pictures.
The next units will discuss the corresponding software so that the multimedia can
function well.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.

Define a multimedia PC.
State the different types of multimedia hardware that a PC can use.
Describe their applications.

7.0
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1.0

INTRODUCTION

In the last unit you studied the multimedia hardware that PCs can work with. You also
require the software packages to enjoy the multimedia.
In this unit, you will be introduced into multimedia software. You will study some
common sound file types; you will also study some common image file types. You will
study video file types. You will also study streaming media.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•

describe the file extension of common sound file types
describe the file extension of some common image file types
discuss the file extension of some common video file types
describe some streaming media.

3.0

MAIN CONTENT

3.1

Common Multimedia File Types

What are these? Can you describe them? Cross check your answers with the ones given
in this section

I hope that you can still remember that multimedia information is exchanged between
computers through files. Remember that the application of Windows programmes
support a variety of multimedia files. These will include sound, music, pictures and
movies. It is important for you to note also that different types of multimedia files are
identified by file extension.

3.2

Common Sound File Types

You will study this section effectively if we present the file types recording to the
corresponding file extensions.
(a)

WAV – Waveform Audio Files

This format represents sound in digital form. Do you have a CD? Remember that the
music in the CD is stored in digital from this is the standard PC audio file format for
everything from system and game sounds to CD quality audio.
(b)

MP 3 – MPEG 1 Audio Player 3

This is a standard technology and format for compressing sound sequences into a
fraction of their original size. This will also preserve the original level of sound quality
when it is played.
(c)

MID – Musical Instrument Digital Interface

This format transmits information about how music is produced on a synthesizer.

3.3

Common Image File Types

Like the last section, we shall present the study of common image file types according to
the corresponding file extensions:
(a)

BMP –Bitmap Image File Types

These will store images as a matrix of pixels without any comprehension.
(b)

TIF, TIFF – TAG Image File Format

This is a common format for exchanging bitmap images between application
programmes including those for scanner images. It can be compressed.

(c)

AWD – AT Work Document File Type

This is used by Microsoft Fax to save images in a compressed black-and-white format for
faxing.
(d)

PG, IPEG – Joint Photographic Experts Group

This is an industry standard file format to represent compressed photographic quality
images
(e)

GIF – Graphics Interchange Format

It represents color images. This file format supports transparency and animation and
makes them very popular in web pages.

3.4

Common Video File Types

We shall describe this according to the respective file extensions:
(a)

AVI – Audio Video Interhoved File Type

This is a popular sound and motion picture file that is supported by Windows.
(b)

MPG, MPEG – Moving Picture Expert Group File

Type

These are an industry types standard for digital video and digital audio compression.
Movies on CD use MPEG 1, DVD uses MPEG 2.
3.5

Streaming Media

This includes audio and video media that are transmitted on the Internet in a continuous
style. Users can make use of the contents of the multimedia file without waiting for the
entire file to download. It is very useful for viewing video clip on the Internet despite the
large size of the video files.
SELF-ASSESSMENT EXERCISE
i.
ii.

Describe common multimedia file types as multimedia software.
State the characteristics of these file types.

4.0

CONCLUSION

In this unit, you have studied the file extension of common sound files types. You
learned the file extensions of image file types and video file types. You also studied
some streaming media. You have increased your knowledge of multimedia software.

5.0

SUMMARY

This unit has introduced you to the study of common multimedia file types. You studied
WAV, MP3 and MID as the common sound file types. You studied BMP, TIF/TIFF, AWD,
JPG/JPEG and GIF as common image file types. You studied AVI, MPG and MPEG as some
of the common video file types.
You studied streaming media. By now your knowledge of multimedia software has
increased. You should be sure that your study of microcomputing and WWW is
progressing effectively. You may want to read through this unit again. The next units
will complete the study of computer hardware, software and multimedia.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.

What are common multimedia file types?
Discuss the common sound file types.
Describe the common image file types.
Describe the common video file types.

7.0
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1.0

INTRODUCTION

What does ME refer to in Windows technology? It means Windows Millennium Edition.
It is designed for use in the house mostly.
All PCs now offer essential multimedia components: a powerful CPU, a sound card, a CD
– ROM or DVD drive, a powerful graphics card and a pair of speakers. ME windows has a
number of tools for assessing, playing or editing multimedia.
In this unit, we shall discuss: Windows media player, sound, recording, imaging and
movie maker

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•
•
•
•
•
•

describe Windows media player
play a music CD
listen to web radio
view a VCD
read and listen to sound in Web page
use Kodak imaging to perform basic task with image documents
explain how a movie maker works
develop skills in performing all these tasks.

3.0

MAIN CONTENT

3.1

Windows Media Player

How does this operate? You will get the details later in this section.
Windows media player can play a wide variety of media files. These include: audio, video
and other multimedia files. It can handle streaming media from the web, once you install
Window ME, you can see that the Windows media player icon appears in the desktop
and the taskbar.
1.

How do you access this? Please follow the instructions below:

•
•

Select start ⇒ Programs ⇒ Accessories ⇒
Click window media player.

How do you play a music CD? To play a music CD:
•

Insert the CD into the CD – ROM drive.

Windows Media Player will start and play back begins automatically.
•
•

Select your preferred track from the right panel and listen to it.
Use appropriate buttons as desired – pause, play, stop, volume control.

2.

Is it possible to listen to a live broadcast of your radio?

You can listen to Federal Radio Corporation of Nigeria through the use of the streaming
media technology, called web casting.
You need to have a multimedia PC and an access to the Internet.
3.

How do you view a VCD?

Windows Media Player can be used to pay a VCD. How does CD function? Remember
that it will start automatically. However, a VCD will not start automatically. You have to
access the appropriate folder in the CD and select the file you want.
Where can you find the video source file?
It is located in the MPEGAV folder.

What is the file type?
It is called DAT. Now follow these instructions to access MPEGAV sub-folder:
•
•
•

Change the files of type: field to all files (* *). Note that the DAT files will appear.
Make your selection.
Click open. What do you observe?

Note that Windows Media Player will be activated. Use appropriate button as you used
in CD to your satisfaction.

3.2

Sound Recorder

Can you add sound recorder to your webpage? Windows ME comes with a sound
recorder tool. How do you do this? Follow these instructions:
•

Select start ⇒ Programs ⇒ Accessories ⇒ Entertainment ⇒ Sound Recorder
from the toolbar.

Notice that a sound – sound record box will show up.
•
•
•

Connect your microphone to your PC.
Click on the record button
Record your message into the microphone. What can you observe?

Note that your voice is displayed in the central wave form of your recorder.
•
•
•
•

Press the stop button when you finish recording
Listen to the message
Click the play button
Click File ⇒ Save with an appropriate name.

3.3

Imaging

How do you add digital photos to your document?
Remember that you can use any of these:
-

Scanner
Digital camera connected to your PC
From CD
From files that you have downloaded from the web
From JPEG format.

However, Windows ME can allow you to view, annotate, and perform basic tasks with
image documents by using Kodak Imaging. This annotation is very useful when you have
a lot of pictures that you want to attach notes to them.
How do you bring up Kodak Imaging for viewing?
Please follow these instructions:
•
•
•

Select from the taskbar Start ⇒ Programs ⇒ Accessories ⇒ Imaging. What do
you observe? Imaging workplace comes up.
Use File ⇒ Open to locate the folder
Select the appropriate file that you want to view.

3.4

Movie Maker

How does the movie maker works?
You will need a VCR and video camcorders. Start Windows Movie Maker.
•
•
•
•

Go to Windows taskbar
Select Start ⇒ Programs ⇒ Accessories ⇒ Entertainment
Click Windows movie maker. Note that the menu of Windows movie maker will
appear
Select Input Function.

This will place the video source into the workplace. Note also that Windows movie
maker can detect and split the video content into sequence clips. Note the changes from
one frame to another.
SELF-ASSESSMENT EXERCISE
1.

Describe how a Window Media Player can be used in playing a music
sound recording, imaging and movie making.

4.0

CONCLUSION

CD,

In this unit, you have described the roles and functions of Windows media player. You
have developed the skills and knowledge to pay a music CD. You have listened to sound
in the webpage. You have used Kodak Imaging to perform basic tasks with image
documents. You have explained how a movie maker works.
You have progressed gradually in this unit, module and course.

5.0

SUMMARY

This unit has introduced you to the study of multimedia support for Windows. You have
developed the necessary skills and knowledge for Windows media player.
You played music CD. You listened to web radio. You viewed a VCD. You recorded and
listened to sound in web page. You used Kodak Imaging to perform basic tasks with
image documents, viewing and annotation. You explained how movie maker works.
Indeed, your study of multimedia hardware, software and support sources for Windows
have been rewarding. Please read through this unit again if you do have any problem.
You are almost ending this course.
Congratulations!

I hope that you have learned a lot from it.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.
iii.
iv.
v.

What is a Windows Media Player?
How do you play a music CD?
How do you view a VCD?
Describe how a move maker works.
How do you add digital photos to your document by using multimedia Windows
support?
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1.0

INTRODUCTION

You need to have a good working environment for you to become efficient at your place.
There is need for accurate interaction between people and their working environment.
Computer scientist calls this Ergonomics.
In this unit, we shall discuss effects of the working environment on computer operators.
The safety conditions shall be described equally.

2.0

OBJECTIVES

At the end of this unit, you should be able to:
•
•
•

describe the efforts of microcomputer components on computer operations
discuss the interaction between people and their working environment within a
computer setting
discuss the safety precautions needed in a computer setting.

3.0

MAIN CONTENT

3.1

Working on a Microcomputer

The working environment in a computer setting in the early 1980s was not so good;
cubicles were used as workstations for data – entry staff. He/she had to read text and
type the text into computers.
Workers under that condition suffered from physical and health problems. These
included headaches, backache, sore eyes and waist injuries. The workers also had stress
and anxiety at their work stations.

In the 1980s microcomputer components produced many things for workers. These
include:
•
•
•

screens emitted dangerous radiation.
badly designed keyboards caused muscular and tendon injuries.
humoring on computers card hand aches.

Studies carried out revealed that the working conditions were responsible for the
minuses other than the microcomputer. These situations are being corrected. In the
next section, we shall discuss these in detail.
3.2

Safety Precautions for Workstations on Microcomputers

Sometimes, if you opened the microcomputer, you will need to observe these
precautions:
•
•
•
•
•
•
•

Find out if your monitor is a high or low radiation type
Does it produce glare that may harm your eyes?
Does it produce any background move?
Find out if your keyboard is designed properly.
What about the lighting conditions?
Can you adjust the light of your chair, the positioning of the monitor and
keyboard?
Listen to your body to observe any abnormalities as a result of the workstation,
e.g. eyes, headache, etc?

How do we improve upon all these?
(a)
(b)
(c)
(d)
(e)
(f)
(g)
(h)
(i)
(j)

You must have your feet flat on the floor.
The height of the main table should be at least 30”.
You must have adjustable seat.
You must have adjustable height chair with 5 legs for stability.
You must have adjustable back rest.
Your arms, elbow must be 90” while arms and hands are parallel to the floor.
The keyboard height must be between 23 – 28 inches depending on height of
operator.
The document holder must be of the same height and distance as the screen.
The viewing angle must be 20” to the centre of screen.
The viewing distance must be between 18 – 28”.

SELF-ASSESSMENT EXERCISE
1.

Visit the URLs to find out more about ergonomics, computer safety and energy
saving.
Ergonomics:
http://www.pcergonomics.com
Energy saving:
< http://cetd.lbl.gov/EA/Buildings/ >
<Research/Energy. Star.htm/>

4.0

CONCLUSION

In this unit, you have used the working conditions on microcomputer. You have studied
the effects of a bad environment on the health of the individual operator. You have
discussed the safety precautions and offered suggestions for a favourable working
environment.

5.0

SUMMARY

This unit has discussed ergonomics - the study of the interaction between people and
their working environment. This applies to a microcomputer. You have identified the
effects on the health of the individual – radiation from the screen, badly designed
keyboards, heavy noise.
Suggestions have been made to improve on these working problems – adjustable seat,
height of chairs, adjustable backrest, the angle of arms elbows, keyboard height,
document holder, etc.
If these conditions are provided, ergonomics will be improved considerably. I hope that
your study of this unit and module has been rewarding. If you have any problems please
feel free to read through any of these units. Well done.

6.0

TUTOR-MARKED ASSIGNMENT

i.
ii.

What is ergonomics?
Discuss the possible health problems that a computer operator may have at
his/her workstation.
Describe the safety precautions an individual must ask his employer to provide for
a successful working environment.
Examine your own PC and see how much of these safety precautions that you
have provided for.

iii.
iv.

7.0
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